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Chapter 1

Welcome to Sage Master Builder 
Installation
This chapter provides information about the following:
Installation Overview

Customer Support Resources

Training Resources

Business Partners

Business Forms
1



Chapter 1
Installation Overview

Welcome to Sage Master Builder installation

Welcome to Sage Master Builder installation. Sage Master Builder can 
run in many different software and network environments. Because of 
that, there are issues that you need to take into consideration for each 
one. The more information you can gain about the installation process 
and how it relates to your software and network environment, the more 
likely your installation will proceed smoothly. 

To gain an understanding of what’s new about product installation: 

• Review the information in this book

• Review the latest the QuickStart Installation Guide

• Read the letter from your business partner.

• Learn about the licensing process. Your Sage Master Builder license 
is managed by a the License Administration Tool and the Sage 
license server. 

What information is in this book?

The rest of Chapter 1 “Welcome to Sage Master Builder Installation” 
provides more information about customer resources, such as:

• Other printed and printable guides

• The user-assistance Help system

• Contacts for Customer Support

• Sage Master Builder training

• Information about business partners.

Chapter 2, “System Requirements and Configuration” presents technical 
information about:

• System requirements for servers and client workstations

• Supported operating systems

• Special configurations for specific operating systems
2



 Welcome to Sage Master Builder Installation
Sage Master Builder will not run correctly or not run at all on 
computers that do not meet the requirements, so before you install 
the software, be sure your computers meet the system requirements. 

Chapter 3, “Sage Master Builder Installation,” provides detailed 
information and instructions for installing Sage Master Builder software 
in different environments, such as: 

• Single user

• Peer-to-peer

• Network 

Chapter 4, “Managing Your License with the License Administration 
Tool,” provides detailed information about:

• Setting the administrator password

• Managing and activating your license

• Creating group reservations

• Using the License Administration Tool. 

Chapter 5, “License Use and Sage Master Builder,” provides all the 
necessary details about:

• Specifying the Sage license server

• Managing license attributes

• Understanding license uses

• Running Sage Master Builder in a “connected” state

Chapter 6, “Special Configurations” contains information about special 
configurations for specific operating systems, such as 

• Windows® 7 Professional and Windows Server 2008® R2 Standard 

• Windows Vista® and Windows Server 2008

• Windows Server 2003®

• Windows XP® Professional

• Citrix® and Terminal Servers
3



Chapter 1
Customer Support Resources

About customer support resources

Sage Master Builder offers a variety of customer support resources. 

Sage Knowledgebase
You can access the Technical Support Knowledgebase 24 hours-a-day, 
seven days-a-week for solutions to frequently asked questions. You can 
also find software alerts and notices, release guides, and year-end close 
information there too. 

To access the Technical Support Knowledgebase: 
1. Click https://customers.sagenorthamerica.com/irj/portal/anonymous/

login. 

2. On the Welcome page, in the left column, click Knowledgebase 
Search to open a list of products. 

3. Complete Step 1 by selecting Sage Master Builder from the list of 
products. 

4. Complete Step 2 by entering a search term in the box.

5. Click Search.

The search results appear below the box. 

Release Updates
To get the latest information about this release, log on to the Customer 
Portal,
https://customers.sagenorthamerica.com/irj/portal/anonymous/login
 Then click Support > Documents > For Customers > Sage Master 
Builder > Release Materials.

Tip:
This is the same online tool our support staff uses when 
responding to calls from service plan customers. 
4
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 Welcome to Sage Master Builder Installation
Online Support
If you would like assistance with a solution and your service plan 
provides online technical support:

1. Log on to: 
https://customers.sagenorthamerica.com/irj/portal/anonymous/login

2. Then click Self Service > My Requests > Customer Support 
Ticket. 
This sends your request directly to Customer Support.

Phone Support
If you need help and your Service Plan provides support assistance, call 
Customer Support at 800-866-8049. Support hours are Monday through 
Friday from 6 a.m. to 5 p.m. PT (Pacific Time).

Remote Assist Tool
The Remote Assist Tool allows Sage Customer Support representatives 
to access your systems and data remotely through your computer to 
provide support services to you and your company. You can access the 
Remote Assist Tool from a Help menu link on the Sage Master Builder 
main page. Point to Help > Customer Resources > Technical Support 
> Remote Assist Tool.

Customer Forums
Exchange information with other Sage Master Builder customers. Log on 
to: 
https://customers.sagenorthamerica.com/irj/portal/anonymous/login
On the Web page Home tab, find and click Forums.

Upgrade Your Service Plan
If your service plan does not provide online technical support, you may 
add or upgrade a service plan by calling 800-858-7098 or by logging on 
to: 
https://customers.sagenorthamerica.com/irj/portal/anonymous/login
Then click Self Service > My Requests > Customer Service Request.
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Chapter 1
Training Resources

About training options

Learning to use Sage Master Builder software has never been easier! 
Whether you choose to take online classes from Sage, participate in 
classroom training, or work directly with your business partner, you will 
learn how to use Sage Master Builder to support your business. Contact 
your business partner to find out about training options or visit 
www.sageu.com/masterbuilder. 

Overview of customer classes
Online classes help make learning Sage Master Builder convenient. Each 
instructor has years of experience using Sage Master Builder and will 
lead you step-by-step through the class material. 

Online classes allow you to view the instructor’s computer screen as he 
or she demonstrates Sage Master Builder software. Once you register for 
your class via Sage University, you will receive email communications 
that tell you how to access the training. Because the classes are live, you 
can ask questions and benefit from hearing other students’ questions. 
Classes cover all aspects of Sage Master Builder, including project man-
agement, estimating, scheduling, and payroll. For more information, visit 
www.sageu.com/masterbuilder. 

Getting started with training
All customers should begin with our New Customer Training (NCT) 
series which is included in our Essentials Training Package in recorded 
format for 24/7 access. These classes include an overview of the Sage 
Master Builder system and its features. Customers that prefer live online 
training can register for the Realtime Learning version of these NCT 
courses. For more information, visit 
www.sageu.com/masterbuilder. 
6
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 Welcome to Sage Master Builder Installation
Business Partners

About Business Partners

To serve you better, Sage Master Builder products and services are 
available to you through an authorized network of business partners.

Your business partner is available to serve you, from simple how-to 
questions and hands-on demonstrations, to installation, implementation, 
and training. They're fully equipped to help you get where you want to 
be. For more information please contact your Sage Master Builder 
business partner.

Business Forms

Sage Construction and Real Estate Forms

Sage Master Builder is designed to work with generic checks and forms 
that are available from many sources. There is no single vendor that 
customers must use; however, you can get a complete portfolio of forms, 
tax forms, and checks through Sage Construction and Real Estate Forms 
by calling 800-760-7929 or by visiting www.timberlineofficeforms.biz 
7
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Chapter 2

System Requirements and 
Configuration
This chapter provides information about the following:
Hardware Requirements

Operating System Requirements

Network Configuration Requirements

Microsoft® .NET Framework® 3.5 Service Pack 1 Requirements

Report Scheduling and Faxing Functionality

Sage Master Builder API
9



Chapter 2
Hardware Requirements

About system requirements and configuration

It is very important to verify that your computers and server meet the 
system requirements for installing and running Sage Master Builder. We 
strongly recommend that you read through these system requirements 
before you begin installing any Sage Master Builder software.

About the Sage System Verifier

The Sage System Verifier utility assists with troubleshooting hardware 
issues related to the Sage licensing component. To locate the Sage 
System Verifier: Start > All Programs > Sage > Sage System Verifier. 

Server hardware specifications

We cannot recommend server hardware specifications for your network 
as this depends on your specific requirements, such as the number of 
users on your network or other programs that might use server resources, 
including firewalls, software applications, mail systems, and so forth. We 
can, however, recommend a set of minimum hardware requirements.

Server hardware requirements

The following table shows the hardware requirements for server 
computers running Sage Master Builder.

Caution!
We strongly recommend that an uninterruptible power system 
(UPS) be connected to the computer (workstation or server) in 
case of a power disruption in which you might lose data. The 
specifications for your UPS must be determined by your needs 
and level of risk.
10



 System Requirements and Configuration
Client and workstation hardware requirements

The following table shows the hardware requirements for client and 
workstation computers running Sage Master Builder.

Caution!
The minimum processor requirements for servers listed in the 
table below are based on the Microsoft® Windows® Server 
2003® operating system family. When updating or purchasing 
servers running newer operating systems such as Windows 
Server 2008®, Small Business Server® 2008, and Server 2008 
R2 Standard, we recommended that you also refer to Microsoft 
system requirements.

Hardware Minimum Recommended

Processor Intel® Pentium® 
4 or comparable

Intel® Dual Core/Quad Core™ or 
comparable, 2 GHz+

RAM 2 GB 4 GB+

Free Disk Space 3.5 GB 3.5 GB+

CD-ROM Drive 2X CD-ROM 24X CD-ROM+, DVD-ROM, or 
DVD RW

Printers For highest quality printing, we recommend laser or ink-
jet printers.

Important: 
These minimum recommendations include the 370 MB of hard 
disk drive space required for running Microsoft .NET 
Framework 3.5 Service Pack 1 software on servers.

Related topics...
Minimum requirements for the .NET Framework on servers
Minimum requirements for the .NET Framework on clients
Client and workstation hardware
11



Chapter 2
Hardware Minimum Recommended

Processor 
(except Vista®/
Windows 7)

Pentium 4 or compar-
able

Intel Dual Core or compar-
able

Vista/Windows 
7 processor

1 GHz 2 GHz+

RAM (except 
Vista/Windows 
7)

1GB 2 GB+

Vista worksta-
tion RAM

2 GB 4 GB+

Free Disk 
Space

1 GB 3 GB+

CD-ROM 
Drive

2X CD-ROM 2X CD-ROM+

Printers For highest quality printing, we recommend laser or ink-
jet printers.

Note: 
• These minimum recommendations include the 230 MB 

required for running Microsoft .NET Framework 3.5 
Service Pack 1 software. on client workstations.

• The recommended free disk space is based on the 
installation of a single program and the average size of a 
Sage Master Builder company database. Allow at least 50 
MB for each additional company database that you create.

Related topics...
Minimum requirements for the .NET Framework on servers
Minimum requirements for the .NET Framework on clients
Server hardware requirements
12



 System Requirements and Configuration
Operating System Requirements

Operating systems

We recommend that the following information be taken into account for 
a smooth and successful installation experience.

Supported Operating Systems 

Server, 32 and 64-bit Operating 
Systems

Client/Workstation, 32 and 64-
bit Operating Systems

Microsoft Windows Server 2008 
R2 Standard

Microsoft Windows 7 
Professional

Microsoft Small Business
Server 2008

Microsoft Windows Vista 

Business

Microsoft Windows Server 2008 Microsoft Windows XP® 
Professional (SP 2 or newer)

Microsoft Windows Server 2003

Microsoft Windows Small 
Business Server 2003® (SP 1 
or newer)
13



Chapter 2
Unsupported Operating Systems

Web browser requirements

Web browser requirements and recommendations are: 

Caution!
Sage Master Builder and/or its components do not run on or do 
not support some operating systems. Do not install Sage Master 
Builder to computers running these Microsoft Windows 
operating systems: 
• Microsoft Windows 95®
• Microsoft Windows 98®
• Microsoft Windows NT® Server 
• Microsoft Windows NT Workstation 
• Microsoft Windows 2000®
• Microsoft Windows 2000 Server®
• Microsoft Windows XP Home ®
• Microsoft Windows Vista Home Basic 
• Microsoft Windows Vista Home Premium
• Microsoft Windows 7 Home

Important:
• Microsoft .NET Framework 3.5 Service Pack 1 must be 

installed to all computers running Sage Master Builder and 
the License Administration Tool. 

• During installation, Microsoft .NET Framework 3.5 Service 
Pack 1 is installed on your computer automatically if it is 
not already installed.

• Be sure that all server and client computers meet both .NET 
Framework requirements and Sage Master Builder 
requirements.

Note: 
When you have a network with three or more users, a dedicated 
file server increases performance and reliability.
14



 System Requirements and Configuration
Network Configuration Requirements

Server network configuration requirements

The following table shows the server network configuration 
requirements for server computers running Sage Master Builder.

Minimum Recommended

Microsoft Internet Explorer® 
6.0, Service Pack 1 or later 
(except Vista/Server 2008, 
Windows 7)

(Vista Business/Windows 7 
and Server 2008 operating 
systems) Microsoft Internet 
Explorer® 7.0 or later. 

Microsoft Internet Explorer 
6.0, Service Pack 1 or later 
(except Vista/Server 2008, 
Windows 7)

(Vista Business/Windows 7 
and Server 2008 operating sys-
tems) Microsoft Internet 
Explorer 7.0 or later. 

Note: 
• Sage Master Builder typically runs in a local area network 

(LAN) environment. 
• Sage Master Builder runs in a wide area network (WAN) 

using Citrix or Terminal Services. Contact your business 
partner for more information. 
15



Chapter 2
Client and workstation network configuration requirements

The following table shows the server network configuration 
requirements for client and workstation computers running Sage Master 
Builder.

About network configuration and TCP Remoting Channel

Sage Master Builder uses the TCP Remoting Channel, a Microsoft .NET 
Framework component to enable communication among computers on a 
network. Certain configurations can potentially disable the 
communication: 

• File sharing on computers running the Vista, Server 2008, or 
Windows 7 operating systems must be enabled. To enable file 
sharing, follow the instructions in the Vista, Server 2008, or 
Windows 7 Help.

Process Required

Network Protocol TCP/IP

Minimum Network 
Speed - LAN

10/100/1000 Mbps

Minimum Network 
Speed - WAN

+/- 1.5 Mbps receiving data 
(downstream)
+/- 384 Kbps sending data (upstream)

Note: 

For information about running Sage Master Builder in a 
wide area network (WAN) using Citrix and Terminal 
Services, contact your business partner. 

Process Required

Network Protocol TCP/IP

Minimum Network Speed - 
LAN

10/100/1000 Mbps

Minimum Network Speed - 
WAN

128 Kbps Broadband
16



 System Requirements and Configuration
• TCP communication requires the selection of port numbers that are 
not in use by other processes on the local computer. 

• Software firewalls running on the local computer can be configured 
to block processes from opening TCP ports, which will prevent 
communication through the TCP Remoting Channel. 

Configuring Sage Service Host TCP port numbers

By default, the Sage Serve Host uses the TCP port numbers 8103 and 
8104. These numbers can be configured using an XML file, 
Sage.SMB.xml, located under: 
\Documents and Settings\All Users\Application 
Data\Sage\LS1\ServiceHost\1.1\Configuration.

To change the port numbers: 
1. In Window Explorer, locate the Sage.SMB.xml under this path: 

\Documents and Settings\All Users\Application 
Data\Sage\LS1\ServiceHost\1.1\Configuration.

2. Right-click Sage.SMB.xml, and open it with a text editor, such as 
Notepad. 

3. Near the end of the file between the <Remoting> </Remoting> 
tags, locate the port numbers and change them. 

4. Save and close the file. 

5. Repeat steps 1-4 on every computer running Sage Master Builder. 

Caution!
If you need to change the default port numbers for the Sage 
Service Host using the Sage.SMB.xml file, you must change 
it on every computer on the network where Sage Master Builder 
is installed. In addition, after making this change, the Sage 
Service Host on each computer running Sage Master Builder 
must be restarted. 

Note: 
Consult with your IT administrator for alternative port numbers. 
17



Chapter 2
Configuring third-party firewalls

During installation of the Sage Service Host, the Windows Firewall is 
configured automatically to allow the Sage Service Host to act as a TCP 
server. If you use some other firewall, however, you may need to 
manually adjust some settings in the firewall in order to ensure proper 
operation.

To configure the Windows Firewall: 
1. Click Start > Control Panel > Security Center (XP) or Security 

(Vista).

2. Open Windows Firewall, and select the Exceptions tab. 

3. If Sage Service Host is not on the list, then you can add it by 
selecting Add Program, then browsing to the following path:
\Program Files\Common\Files\Sage\LS1
\ServiceHost\1.1\Sage.LS1.ServiceHost.exe.

Microsoft .NET Framework 3.5 Service Pack 1 
Requirements

About installation and Microsoft .NET Framework

When you install Sage Master Builder software, you will also install the 
Microsoft .NET Framework 3.5 Service Pack 1, if it is not already 

Note: 
You can use the following basic procedure to manually 
configure the Windows Firewall to allow the Sage Service Host 
to communicate with other computers. Use it as the basis for 
manually configuring other third-party firewall products.

Note:
By default, the exception is set to allow access by any computer 
on the network. If desired, you can refine this setting by 
selecting the Change Scope button. Be aware that restricting the 
scope incorrectly can cause the computer to be unable to connect 
with some or all of the other machines on the network.
18



 System Requirements and Configuration
installed. It is important that you make sure that both your client and 
server computers meet the minimum requirements for installing both 
Sage Master Builder software and the .NET Framework 3.5 Service 
Pack 1. 

About installing .NET Framework 3.5 Service Pack 1 and Operating 
Systems

The following are the supported operating systems for .NET Framework 
3.5 Service Pack 1:

• Windows 7 Professional 

• Windows Server 2008 R2 Standard

• Windows Vista Business

Important: 
If the Sage Master Builder installation requires an installation of 
Microsoft .NET Framework 3.5 Service Pack 1, the Sage Master 
Builder installation process may continue automatically after the 
.NET Framework installation is completed. If you are prompted 
to restart your computer after the .NET Framework installation, 
however, you must do it to continue the Sage Master Builder 
installation. 

Note: 
If Microsoft .NET Framework 3.5 Service Pack 1 is not already 
installed on your computers, then that installation alone may 
take up to 20 minutes per computer.
19
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• Windows Server 2008

• Windows XP Professional

Viewing and verifying system information

You may use the Winmsd.exe to open the System Information 
window to view a list of your system information. 

To view and verify system information: 
1. Click Start, then click Run. 

The Run dialog box opens.

2. In the Open text box, type winmsd.exe, and then press the Enter 
key. 

The System Information window opens displaying a list of your 
system information.

.NET Framework Requirements for Server Computers

Minimum requirements for the .NET Framework 3.5 Service 
Pack 1 on servers

The following table shows the .NET Framework requirements for 
computers running Sage Master Builder.

Component Required

Hard disk space at installation 800 MB

Hard disk space to run 370 MB

Video card 800x600, 256 colors

Related topics...
Server hardware requirements
Client and workstation hardware requirements
Minimum requirements for the .NET Framework on clients
20
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.NET Framework Requirements for Client Computers

Minimum requirements for the .NET Framework 3.5 Service 
Pack 1 on clients

Verifying that Microsoft Internet Explorer 6.0 Service Pack 1 is 
installed

You need to have Microsoft Internet Explorer 6.0 Service Pack 1 
installed on a client to meet minimum requirements for running Sage 
Master Builder software. This is also a requirement for installing and 
running .NET Framework 3.5 Service Pack 1. 

To verify that Microsoft Internet Explorer 6.0 Service Pack 1 is 
installed: 
1. Launch Internet Explorer.

2. On the Internet Explorer Help menu, click About. 

3. In the About Internet Explorer dialog box, verify that the version 
number is 6.0 Service Pack 1 or newer, and then click OK. 

Component Required

Hard disk space at installation 160 MB

Hard disk space to run 70 MB

Video card 800x600, 256 colors

Related topics...
Server hardware requirements
Client and workstation hardware requirements
Minimum requirements for the .NET Framework on servers
21
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Report Scheduling and Faxing Functionality

About setting up emailing and faxing through Sage Master Builder

Important information regarding Report Scheduling and 
Faxing Functionality 
Using the faxing functionality through the Sage Master Builder program 
requires a separate installation and setup procedure for a fax modem in 
your workstation and access to an analog phone line. You may also have 
to set up the cover page information and the number of times that the fax 
re-tries to send. 

For more information about installing and setting up your fax modem, 
refer to the documentation that came with your fax modem. Sage Master 
Builder does not provide support for installing or setting up a fax 
modem.

Faxing Functionality and Operating Systems
Faxing functionality through Sage Master Builder only works with 
Windows XP Professional, Windows Server 2003, Vista Business, 
Windows 7 Professional operating systems, and Windows Server 2008. 
Faxing functionality requires that Adobe Reader 8.1.3 or higher is 
installed on the computer doing the faxing. 

Upgrade to Adobe Reader version 8.1.3
Adobe Reader Version 8.1.3 supports faxing from Windows. To fax from 
Sage Master Builder, you should download and install 8.1.3 or higher.

Important: Customers have reported problems faxing from Sage Master 
Builder with versions earlier than 8.1.3. This version is available from
http://get.adobe.com/reader 

Note: 
To download Service Pack 1 for of Microsoft Internet Explorer 
6.0, visit the following Microsoft Web site: 
http://www.microsoft.com/windows/ie/ie6/downloads/critical/
ie6sp1/default.mspx 
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Disengage automatic updating for Adobe Reader
If you are using the scheduling capability for sending faxes, we 
recommend that you disengage the automatic “check for updates” 
capability of Acrobat Reader as it will prevent scheduled reports from 
completing.

Report Scheduling and Email Functionality 

Using the ISP’s simple mail transfer protocol (SMTP) server to send 
email via Sage Master Builder typically requires “user authentication” at 
the STMP server. An example of an SMTP email server name is 
“smtp.att.sbcglobal.net.”

Different ISPs may use different terms when referring to user 
authentication. In general, however, user authentication means verifying 
a user’s identity by means of a “user name” and “password.” 

In the context of sending email through Sage Master Builder using an 
ISP’s SMTP server, user authentication only refers to verifying the user’s 
identity at the ISP’s SMTP server. It does not refer to your: 

• Sage Master Builder user name and password

• Network domain user name and password

• Windows system user name and password. 

Note: 
Instructions disengaging automatic “check for updates” differ 
from version to version of Adobe Reader. Refer to the Adobe 
Reader Help for instructions. 

Important: 
Using the email capability of Sage Master Builder requires 
access to a simple mail transfer protocol (SMTP) email server. 
This server may be located on your workstation PC, on a server 
on your company’s network, or at your Internet service provider 
(ISP). If the email server is local, you may need the assistance of 
an IT professional to properly identify or set up this capability. If 
the email server is located at your ISP, you may need contact 
your ISP for assistance. 
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Installing the Windows Fax Services component

To fax from Sage Master Builder, you have to install the Windows Fax 
Services component.

To install the Windows Fax Services component (XP): 
1. Open the Window Control Panel. 

2. On the Control Panel window, double-click Add or Remove 
Programs. 

3. On the Add or Remove Programs window in the left column, click 
the Add/Remove Windows Components icon. 

4. On the Windows Components Wizard window, select the Fax 
Services check box, and clear all the other check boxes. 

5. Click Next, and follow the instructions on the screen. 

To install the Windows Fax Services component (Vista): 
1. Click Start > Control Panel > Programs > Turn Windows 

features on or off.

2. On the Windows Features window, locate the Windows fax and 
scan check box, then select it. 

3. Click OK.

Note:
• We do not provide support for setting up or installing an 

email server.
• You set up user authentication and your fax line access dial-

out number on 7-2 Company Information. For more 
information, see the Help topic, “Entering company 
information.” 
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Sage Master Builder API

System requirements for Sage Master Builder API

If you are using the Sage Master Builder API, the minimum and 
recommended system requirements may vary. These requirements must 
be considered in addition to the recommended system requirements for 
running Sage Master Builder. 

It may be necessary to increase the processor speed, memory, and/or disk 
space of your system depending upon the requirements of the third-party 
application using the API. Please consult with your third-party vendor to 
determine what changes, if any, should be made to your hardware 
configuration in order to meet your desired performance criteria.
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Sage Master Builder Installation
This chapter provides information about the following:
Installation Preview

New Installations

Upgrade Installations
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Installation Preview

Pre-installation information for new customers

Implementing and running your business in Sage Master Builder must be 
thoroughly planned out in advance to harness the tremendous power of 
this software. Your existing company data must be migrated before you 
start working in the program. Your business partner can assist you with a 
data migration and business implementation plan. For more information 
about implementing Sage Master Builder for your company, see the 
information about business partners in Chapter 1 of this guide. 

We recommend that you take full advantage of all the knowledge and 
advice found in Sage Master Builder documentation and training classes. 
We also recommend that you work with your business partner and 
accounting professionals before you begin to implement this software for 
your business. 

We strongly recommend that you install the Sage license server on a 
computer that is always available to other computers on your network 
that are running Sage Master Builder.

Pre-installation information for existing customers

Because existing customers are working with company information and 
possibly with scheduled reports, please review these important points 
before you start to install the program.

Important: 
• When you reinstall or upgrade, turn off scheduled reports. 

Reports must not be printed, faxed, or emailed at the same 
time that you reinstall or upgrade the program. 

• Do not upgrade or reinstall Sage Master Builder while the 
Sage Master Builder program or the API is running. 

• Before you install, make at least one backup copy, but 
consider making two backup copies of your existing 
company data for an extra margin of safety. Click here to 
jump to data backup information.
28



 Sage Master Builder Installation
Duration of the installation process

Plan on at least five and possibly up to 20 minutes per computer to install 
Sage Master Builder and its companion software, such as the Sample 
Company and the License Administration Tool. The duration of the Sage 
Master Builder installation depends a great deal upon each computer’s 
configuration. For example, some newer computers are pre-installed 
with essential software required to run Sage Master Builder software 
such as the .NET Framework 3.5 Service Pack 1 and the Windows 
Installer 3.1. Installation to older computers may take more time.

Additional required software

Both Windows Installer 3.1 and the Microsoft .NET Framework 3.5 
Service Pack 1 must be installed on all computers running Sage Master 
Builder software. The installer determines if the .NET Framework 3.5 
Service Pack 1 and the Windows Installer 3.1 are already installed. If not, 
the installer installs the required software automatically.

Plan for an additional 10 to 15 minutes per computer to install .NET 
Framework 3.5 Service Pack 1 and Windows Installer 3.1 on each 
computer. 

Important: 
If you need to install Windows Installer 3.1, then the computer 
must restart before you continue with the Sage Master Builder 
installation. After your computer restarts, opening and closing 
your CD drawer with the installation CD in it should restart the 
Sage Master Builder installation. If the install program does not 
start automatically, go to Start > Run > Browse, locate your CD 
drive and select setup.exe. Then click OK. 

Important: 
It is very important that you understand the network 
environments and operating systems on the computers and 
server computers where you install Sage Master Builder 
software. Chapter 6 Special Configurations provides detailed 
information about installing to different environments.
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About installing the Sage Master Builder software to different 
configurations

You can install Sage Master Builder software to many different 
configurations, for example, stand-alone, network server, Citrix and 
Terminal Services servers, peer-to-peer, and workstations.

Sage Master Builder allows users to share data and reports stored on a 
network hard drive. From different workstations, users can then access 
the server to share one set of data, one set of reports, and one set of report 
forms.

During installation, the installer checks for the components necessary to 
run Sage Master Builder and then copies the program modules and 
reports to the \MB7 folder and subfolders that are created on the hard 
disk. In addition, the installation process copies system files necessary 
for program operations to the Windows and Windows System 
folders.

The installation process does not make any configuration changes to the 
computer. After installation is complete, you must configure the stand-
alone computer, server computer, or workstation for optimal 
performance. For example, you need to configure the date format on 
computers running the Windows Server 2003 operating system. For 
detailed information about configuring each server and workstation 
depending on its operating system, see Chapter 6, Special Configurations 
under the section, Citrix and Terminal Servers.”

Important: 
• The optimal operational size of a peer-to-peer network 

running Sage Master Builder is two to five workstations. 
Additional workstations may adversely impact Sage Master 
Builder response times. Networks consisting of more than 
five (5) workstations may need to use one computer as a 
dedicated server.

• For installation to Citrix and Terminal Servers, see Chapter 
6, Special Configurations under the section, Citrix and 
Terminal Servers.”
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Connectivity across your network

For all client workstations running the program to be connected to your 
company data, they must all be connected to the Sage license sever. If 
one user sees the “unable to connect” message when all other people are 
connected, then you know that the connectivity problem is limited to that 
one person. If you encounter a hardware failure with your server, then all 
the people running Sage Master Builder will be disconnected. 

License Administration Tool 

Installing Sage Master Builder also installs the License Administration 
Tool, a Sage licensing application. You can log on to the tool from any 
computer on the network see who is using the program in “read-only” 
mode. In addition, the administrator for the License Administration Tool 
can log on in “administrator” mode to work with such tasks as activating 
your license and registering new modules. 

Option to update reports and report forms on a shared drive 
during installation

If you are running Sage Master Builder in a network environment, this 
option enables you to update shared system reports and report forms 
located on a network drive during installation. You no longer have to run 
the installation twice. 

When you select this option, the installation process enables a list of 
network drives that already have an \MB7 folder. 

Related topics...
Configuring third-party firewalls
Installing on computers running Citrix and Terminal Servers 
using DOS commands

Important: 
This option only updates system reports and report form files. It 
does not perform a complete installation. If you need to be able 
to run Sage Master Builder on the targeted server or the server’s 
licensing needs to be updated, you must do a complete 
installation directly on the server.
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Installing the Sample Company

The Sample Company provides the means for viewing and working with 
sample data in Sage Master Builder windows. There are sample 
accounts, sample employees, sample takeoffs, and much more. By 
viewing and working with this sample data, you can gain an 
understanding of how different windows interact with the sample data 
when managing a construction business with Sage Master Builder. 

Sage Master Builder master trainers use the Sample Company exten-
sively during Sage Master Builder training classes. We highly recom-
mend that you load the Sample Company during your initial installation. 

You can log on to the Sample Company using “Supervisor” as the user 
name. You do not need a password. 

The Sample Company:   

• Allows you a safe way to try out new functions as you learn them.

• Is used in many on-line and recorded classes.

• Provides samples of many Sage Master Builder forms that are all 
filled in. This makes it easy to understand many concepts.

• Provides starter lists for many values you'll need to set up: cost 
codes, cost types, tasks, client status, client type, employee positions, 
paygroups, etc.

• Provides you with live data to investigate the content of Sage Master 
Builder reports.

• Takes very little space on your hard disk drive.
 

Important: 
• Installing the Sample Company overwrites any previous 

installations of the Sample Company. 
• If you have made changes in your Sample Company that 

you wish to keep, rename this folder before installing a 
fresh copy of the Sample Company.
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New Installations

About new installations

A new installation is defined as:

• Installing the software on a computer that has never had Sage Master 
Builder installed on it before. 

• Installing the software on a computer where Sage Master Builder and 
Sage Licensing has been removed using Control Panel > Add or 
Remove Programs.

You must designate one computer on your network as the Sage license 
server. This server will manage use of Sage Master Builder; for example, 
the number of people who can use Sage Master Builder simultaneously 
on your network. You will need to install the software on this computer 
first and then activate your licenses before installing Sage Master Builder 
on your other computers.

The installation package of files is the same whether it is available to you 
on a CD or in a folder on a network drive. 

There are several way to install the program: 

• You can install Sage Master Builder from the product CD at each 
computer. 

• You can copy the entire CD (all files and folder) to a folder that you 
create on a network drive and then install to each client workstation 
by launching the installation from that network folder from that 
client workstation. 

No matter which installation method you use, we recommend that you 
install to the Sage license server computer first. Then when you install 
the program to your workstations, you can set up Sage Master Builder to 
find the Sage license server and run the program using you license. 

Note: 
Instructions for reinstallation/upgrade installation over an 
existing installation are different. See Upgrade Pre-installation. 
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The installation process also presents different installation windows 
depending on whether you are installing the Sage license server and Sage 
Master Builder or you are just installing Sage Master Builder by itself. 

Basic steps for new installations are:

1. First install the program on your network server, the computer where 
all your company data is located. You do this only once on your 
network. Remember to write down the Sage license server 
computer’s IP Address and/or computer name, which is displayed at 
the end of the installation.

2. Next, activate your license.

3. Install the program to all client workstations on your network.

4. From each client workstation, specify the Sage license server.

Installing the Sage license server and Sage Master Builder

When you choose the option to install the Sage license server, you also 
install Sage Master Builder. 

Use these instructions when: 

• Installing the software on a computer that has never had Sage Master 
Builder installed on it before. 

• Installing the software on a computer where Sage Licensing and 
Sage Master Builder has been removed using Control Panel > Add 
or Remove Programs.

• Also select this option if you are running in a stand-alone 
environment. Stand-alone means that you are running Sage Master 
Builder on one computer, or you are not networking with other 
computers running Sage Master Builder.

Find your installation method below, either CD or network folder, and 
follow the installation instructions. 

Important: 
Always start installing the program at the computer that will be 
your Sage license server, which is likely to be your network 
server. 
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To install the Sage license server and Sage Master Builder 
from a CD:
1. Close all open programs except for firewall and antivirus programs.

2. Insert the Sage Master Builder CD into your CD-ROM drive. 

If the install program does not start automatically, go to Start > Run 
> Browse, locate your CD drive and select setup.exe. Then click 
OK. Click here to jump to the rest of the installation instructions. 

3. After the installation begins, click here to go to the rest of the 
instructions. 

To install the Sage license server and Sage Master Builder 
from a CD image in a network folder: 
1. Close all open programs except for firewall and antivirus programs.

2. On a network drive, create a folder named, for example, Master 
Builder 15 CD Image.

3. Copy the entire contents of the CD (all files and folders) to that 
folder.

4. In the folder that you have created, locate the setup.exe file and 
double-click it.

5. After the installation begins, click here to go to the rest of the 
instructions. 

Complete the installation using these steps: 
1. Read the instructions on the installation welcome window, and click 

Next. 

2. On the installation option window, select the option This computer 
will be my Sage license server, and click Next. 

3. On license agreement window, read the License Agreement 
carefully. 

4. Select the check box to accept the terms, then click Next to continue 
the installation. 

The select a drive window appears.
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5. Select a local drive location for the installation, and click Next.

In the next installation window, you are presented with either one 
option or two options: 

6. On the select additional options window: 

a. Install the Sample Company for training purposes. We 
recommend that you install the Sample Company. 

b. Update reports and report forms on a local or network drive. This 
does not install the entire Sage Master Builder program on the 
other drive. It only updates the system reports and report forms.

The installer begins the installation process. It checks to see if the 
computer has .NET Framework 3.5 Service Pack 1 and Windows 
Installer 3.1 installed. If these programs are not found, the installer 
installs them. Sage Master Builder Version 15 does not install the 
.NET Framewor 3.5 Service Pack 1. 

Important: 
Sage Master Builder should always be installed to a local drive. 
You can share Master Builder data that is located on a network 
drive among client workstations that are running Sage Master 
Builder locally.

Note: 
This option may not appear for first-time installations because it 
is unlikely that a shared \MB7 folder already exists on your 
network.
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At the end of the installation process, a confirmation window 
appears containing a list of installed programs. Here is an example.

• Sage license server software

• License Administration Tool

• Sage Master Builder

• Sample Company

This window also displays the computer’s IP Address and its 
network name. You will use this information to specify the Sage 
license server.

7. Review the list of installed programs, and write down the IP Address 
and network name of the computer.

8. Click Next. 

The activate your product license window appears. The Launch the 
License Administration Tool check box is pre-selected to launch 
the License Administration Tool so you can activate your license.

Note: 
• If you need to install Windows Installer 3.1, then the 

computer must restart before you continue with the Sage 
Master Builder installation. After your computer restarts, 
opening and closing your CD drawer with the installation 
CD in it should restart the Sage Master Builder installation. 

• If the install program does not start automatically, go to 
Start > Run > Browse. Locate your CD drive or CD image 
folder, select setup.exe, and then click OK. 

• If your computer security warns you that Sage Licensing is 
trying to access the Internet, click Allow.

Important: 
Write down and keep the Sage license server computer’s IP 
Address and name in a convenient location. To select the Sage 
license server from client computers running Sage Master 
Builder, you need to select its name from a list or type the 
computer’s IP Address or name in a text box.
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9. Read the instructions about activating your product license, and then 
click Finish, leaving the Launch the License Administration Tool 
check box selected. 

10. The Logon Administrator Password window opens. 

11. Set the Administrator password. 

For information about this process, click the Help button on the 
Logon Administrator Password window. 

For details about managing your license, see Chapter 4, Managing 
Your License with the License Administration Tool.

Installing Sage Master Builder on client workstations

Find your installation method below, either CD or network folder, and 
follow the installation instructions. 

To install Sage Master Builder only from a CD:
1. Close all open programs except for firewall and antivirus programs.

2. Insert the Sage Master Builder CD into your CD-ROM drive. 

If the install program does not start automatically, go to Start > Run 
> Browse, locate your CD drive and select setup.exe. Then click 
OK. Click here to jump to the rest of the installation instructions. 

3. After the installation begins, click here to go to the rest of the 
instructions. 

To install Sage Master Builder only from a CD image in a 
network folder: 
1. Close all open programs except for firewall and antivirus programs.

2. On a network drive, create a folder named, for example, Master 
Builder 15 CD Image.

3. Copy the entire contents of the CD (all files and folders) to that 
folder.

4. In the folder that you have created, locate the setup.exe file and 
double-click it.
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5. After the installation begins, click here to go to the rest of the 
instructions. 

To complete the installation of Sage Master Builder:
1. Read the instructions on the installation welcome window, and click 

Next. 

2. On the installation option window, select the option This computer 
will run Sage Master Builder only, and click Next. 

3. On the license agreement window, read the License Agreement 
carefully. 

4. Select the check box to accept the terms, then click Next to continue 
the installation. 

The select a drive window appears. 

5. Select a local drive location for the installation, and click Next.

The installer begins the installation process. It checks to see if the 
computer has .NET Framework 3.5 Service Pack 1 and Windows 
Installer 3.1 installed. If these programs are not found, the installer 
installs them. 

6. On the select additional options window:

a. Install the Sample Company for training purposes. We 
recommend that you install the Sample Company. 

b. Update reports and report forms on a local or network drive. This 
does not install the entire Sage Master Builder program on the 
other drive. It only updates the system reports and report forms.

 The installer begins the installation process. It checks to see if the 
computer has .NET Framework 3.5 Service Pack 1 and Windows 
Installer 3.1 installed. If these programs are not found, the installer 
installs them. Sage Master Builder Version 15 does not install the 
.NET Framewor 3.5 Service Pack 1. 

Note: 
This option may not appear for first-time installations because it 
is unlikely that a shared \MB7 folder already exists on your 
network.
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An installation complete window appears. The Launch Sage 
Master Builder check box is preselected so that you can launch 
Sage Master Builder and specify the Sage license server. 

7. Read the important message and follow the instructions to launch 
Sage Master Builder. 

8. Click Finish. 

Master Builder begins its launch process by displaying the Specify 
Sage License Server window. 

For more information about this process, you can click the Help 
button on the Specify Sage License Server, or see Chapter 5 License 
Use and Sage Master Builder.

Upgrade Installations

About upgrading Sage Master Builder

If you currently have Sage Master Builder installed on your network 
computers and you are going to reinstall it, you could be either upgrading 
or updating the software. 

Note: 
• If you need to install Windows Installer 3.1, then the 

computer must restart before you continue with the Sage 
Master Builder installation. After your computer restarts, 
opening and closing your CD drawer with the installation 
CD in it should restart the Sage Master Builder installation. 

• If the install program does not start automatically, go to 
Start > Run > Browse. Locate your CD drive or CD image 
folder, select setup.exe, and then click OK. 

• If your computer security warns you that Sage Licensing is 
trying to access the Internet, click Allow.

Related topics...
About upgrading Sage Master Builder
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Upgrade installations involve major changes, enhancements, and fixes to 
many parts of the program or to modules such as licensing. For example, 
installing Version 15 over Version 14 is an upgrade installation because 
there are major enhancements to the program. 

Update installations, in contrast, usually involve changes to specific files, 
such as the Sage.SMB.PayrollTax.dll file and report forms. 
These files can be changed and updated without any changes to major 
parts of the program.

In addition, upgrade installations are different from a new installations. 

• During a new installation (or reinstallation after completely 
removing Sage Master Builder and Sage licensing), you can 
designate a computer to be either the Sage license server or a client 
work station. 

• During an upgrade installation, the installer checks to see if Sage 
licensing exists on that computer. If the installer detects a previous 
installation, the installer follows the prior installation path for that 
computer. You do not see the option to select a designation. If a 
computer had previously been the Sage license server, it will be 
reinstalled/upgraded again as the Sage license server. 

Upgrade Pre-installation

Upgrade pre-installation tasks

Upgrading your Sage Master Builder software requires that you 
complete preliminary tasks to ensure the safety of your company data. 

When upgrading, it is important that you choose a block of time when 
you can install the upgrade to all the computers in your office beginning 
with your Sage license server computer. Depending on your computer’s 
hardware and your network configuration, plan on 15 minutes per 

Note: 
If you want to change a computer’s designation as either a Sage 
license server or a client workstation, you need to uninstall the 
Sage licensing and the Sage Master Builder program using 
Control Panel > Add or Remove Programs. How?
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computer for the installation process alone. Additional tasks may take 
extra time.

The following are steps to take before upgrading Sage Master Builder: 

1. Make two backups of your company data - We suggest making 
two backups in case one of them is incomplete, becomes corrupted, 
or is lost. Click here to jump to data backup information.

2. Make sure that no reports are scheduled to run during 
installation - Plan your upgrade installation during the time when no 
reports are scheduled to be printed, faxed, or emailed. For 
instructions, open the Sage Master Builder Help and search using the 
Help search shortcut term “schedulereports.” More topics about 
scheduling reports are located at the end of the topic “About report 
scheduling.” 

3. Exit Sage Master Builder and all other programs - You must not 
install the Sage Master Builder upgrade when either Sage Master 
Builder or the  Sage Master Builder API are running. We recommend 
that you shut down all other programs when installing Sage Master 
Builder, but you do not have to shut down firewall and antivirus 
software. 

4. Locate the computer on your network that is your Sage license 
server, and begin the upgrade installation there. 

Upgrade Installation

About installing the upgrade

Always begin all installations at the computer that is the Sage license 
server. After installing the upgrade to the Sage license server, install the 
upgrade to your workstations from the image placed in a folder on the 
network. 

Sage Master Builder running on client workstations needs to connect to 
the Sage license server to access your company data. If you do not 
change the designation of any computers on your network during an 

Related topics...
About upgrading Sage Master Builder
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upgrade installation, all client workstations will be able to locate the 
existing Sage license server again after installation. 

In addition to installing the Sample Company, you may have the option 
to update system reports and report forms on a local or network drive. 
For example, let’s suppose that your system reports and report forms are 
located on a shared drive M under an existing \MB7 folder. Now during 
Sage Master Builder installation to drive C on your local computer, you 
can also update system reports and report forms to shared drive M. 

This option is only available if an \MB7 folder already exists on a 
different local or network drive. Updating system reports and report 
forms on different drive does not install the Sage Master Builder 
program. For example, if you want to install Sage Master Builder to a 
network drive, you have to go to that computer and install the program 
from there. 

Installing the upgrade

When installing, use the same upgrade installation steps for both your 
Sage license server and your workstation computers.

To install the upgrade from a download package unzipped into 
a local or shared folder: 
1. Shut down Sage Master Builder and all open programs except for 

firewall and antivirus programs.

2. Browse to the drive and folder where you extracted the upgrade files 
in the steps above.

3. Before you proceed further with installation, we recommend that you 
double-click ReleaseNotesv15.pdf to open it in your PDF viewer. It’s 

Note: 
You only need to update your system reports and report form 
once on the shared drive from one computer on your network. 

Important: 
Install the upgrade to the existing Sage license server 
computer first. Install the upgrade to all workstations only after 
the license server installation has been completed. 
43



Chapter 3
a good idea to review the Release Notes for information about 
“Enhancements,” “Fixes,” and “Known issues and Comments” that 
might apply to your network configuration and/or operating systems 
and affect your upgrade installation. 

4. Double-click Setup.exe to begin the installation. 

• If you are running the Windows XP operating system and you 
get a message advising you that the program publisher cannot be 
identified, click [Run]. 

• If you are running the Windows Vista operating system and you 
get a message advising you that an unidentified program wants 
to access your computer, click [Allow]. 

• If you are running the Windows 7 or Server 2008 R2 operating 
system and you get a message asking if you want to allow the 
following program to make changes to this computer, click 
[Yes].

5. After the installation begins, follow the rest of the instructions below. 

To complete the upgrade installation: 
1. On the welcome window, notice that a previous installation has been 

found, and click Next. 

2. On license agreement window, read the license agreement carefully. 

3. Select the check box to accept the terms, and then click Next.

4. On the select a drive window, select the local drive where Sage 
Master Builder is currently installed. 

5. On the select additional options window: 

a. The installation process automatically selects the option to 
install the Sample Company. We recommend that you install the 
Sample Company, which is used extensively in Sage Master 
Builder training classes. 
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b. (If available) Update reports and report forms on a local or 
network drive. This does not install the entire program to the 
other drive; it only updates the system reports and report forms. 
This only needs to be done from one workstation. 

6. Click Next. The installation proceeds. 

7. On the Installation complete window, click Finish to launch Sage 
Master Builder. 

8. Repeat steps to upgrade all other computers running Sage Master 
Builder. 

9. Follow the instructions for post-installation tasks to rebuild the 
indexes your company database from one computer and reschedule 
your reports, as necessary. 

Resetting the Sage license server computer

In certain instances, you may encounter a Sage license server 
identification issue. After installing the upgrade, Sage Master Builder 
should automatically identify the same license server computer as it did 
before the upgrade. 

Important: 
• The upgrade installation overwrites the existing Sample 

Company. If you want to save changes to the existing 
Sample Company, clear the check box. If you do not 
overwrite the Sample Company, you must rebuild the 
indexes in the Sample Company database using 7-4 
Rebuild Indexes after the upgrade installation.

• If you have made changes in your Sample Company that 
you wish to keep, rename this folder before installing a 
fresh copy of the Sample Company.

Note: 
On PCs running the Vista operating system, if you receive a 
Windows Program Compatibility Assistant message after 
completing the installation advising you that the program may 
not have installed correctly, click the option, This program 
installed correctly.
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To reset the license server computer: 
1. On a different computer running Sage Master Builder connected to 

the Sage license server, launch Sage Master Builder, and then click 
File > Change Sage License Server.

2. On the Change Sage License Server window, look at the first line, 
and write down the Sage license server IP address. An IP Address is 
a series of numbers that identifies the computer on a network, for 
example, 10.227.16.40.

3. Go back to the computer that cannot find the Sage license server, 
launch Sage Master Builder, and then click File > Change Sage 
License Server.

4. On the Change Sage License Server window, select the second 
option, Enter the IP Address or name of the computer, and follow 
the instructions on the window.

If you need more information, refer to the Help topic, “Changing the 
Sage license server.” Find it quickly by search the Help with the Help 
search shortcut term, “changelicenseserver.”

Upgrade Post-installation

Upgrade post-installation tasks

Once you have completed your upgrade installation, perform the 
following tasks before you open your company and begin work in Sage 
Master Builder.

1. Launch your company and rebuild indexes - Before you can work 
in the Sage Master Builder company data, you have to rebuild the 
indexes of each company in which you do work. This process 
upgrades the company databases to the new version. 

For instructions, open the Sage Master Builder Help and search 
using the Help search shortcut term “indexdatabase.” 

Important: 
When launching Sage Master Builder on a workstation and you 
see the message, “Unable to find license server,” you can reset 
the license server computer with a few steps.
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2. Reschedule your reports - If you had to delete scheduled reports 
that would have interfered with the upgrade installation, return to the 
report scheduling window and reschedule your reports. 

For instructions, open the Sage Master Builder Help and search 
using the Help search shortcut term “schedulereports.” More topics 
about scheduling reports are located at the end of the topic “About 
report scheduling.” 

Change Sage License Server Designation

About reinstalling to change the Sage License Server designation

If you want to change a computer designation from client workstation to 
Sage license server or vice versa, you must first uninstall the Sage 
License. Use Control Panel > Add or Remove Programs to uninstall 
the Sage License, then reinstall the Sage Master Builder program. This 
approach produces the equivalent of a new installation. 

If you reinstall Sage Master Builder over an existing installation, the 
installation process reinstalls the program to the designation selected in 
the initial installation. Therefore, after reinstallation, a Sage license 
server computer remains a Sage license server and a client workstation 
remains a client workstation.

Important: 
You only have to rebuild the indexes for each company’s 
database one time from one computer using 7-4 Rebuild 
Indexes. 

Related topics...
About upgrading Sage Master Builder

Note: 
Simply reinstalling Sage Master Builder on a computer that is 
the Sage license server does not affect your license settings or 
reinstall the License Administration Tool. 
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To change a computer designation by reinstalling (changing a 
workstation computer into the Sage license server or the Sage license 
server into a workstation):

1. Uninstall Sage Licensing from the Control Panel > Add or Remove 
Programs. 

2. Reinstall Sage Master Builder following the instructions for new 
installations.

The procedures for new installations are in the Sage Master Builder 
Installation and License Administration Guide (Version 15). This book is 
available as a PDF file on the product CD. Information about new 
installations is in chapter 3, “Sage Master Builder Installation,” in the 
subsection, “New Installations.” 

Add a New Server

Adding a new server to your network

You bought a new server to add to your network. You want to reinstall 
your old server as a client workstation. 

To add a new server to your network: 
1. First uninstall Sage Licensing and Sage Master Builder from your 

current server using Control Panel > Add or Remove Programs. 

2. Then install Sage Master Builder to the new server with the 
designation as Sage license server. Don’t forget to write down the 
Sage license server computer’s IP Address and computer name. 
Click here to jump to the instructions for new installations.

3. Activate your license and perform other Sage license server tasks.

4. Go to each client workstation, and specify the new Sage license 
server. Make sure that each client workstation can find and connect 
to the Sage license server.

5. Install Sage Master Builder on the computer that was the old server 
and specify the new Sage license server. Make sure that the client 
workstation can find and connect to the Sage license server.
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Managing Your License with the License 
Administration Tool
This chapter provides information about the following:
License Administration Tool

Monitoring Product and Feature Use

Managing Licenses

Managing Reservations

Troubleshooting Network Disconnection Issues
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License Administration Tool

About the License Administration Tool for Sage Master Builder 

When you purchase Sage Master Builder software, it includes the 
License Administration Tool. Using the License Administration Tool, 
you can import license files, activate licenses, reserve the use of products 
and features, and monitor the use of products and features. This tool also 
supports site licenses and floating use licenses. During software 
installation, the License Administration Tool is automatically installed 
on the computer that the software installer designates as the Sage license 
server.

Where is the Sage license server located?
The Sage license server is software running on a computer on your 
network that manages the Sage Master Builder products and features that 
you purchased. Products and features can be a “core product,” additional 
“modules,” and a number of “license uses.” The computers running your 
Sage Master Builder have to be connected to the computer running the 
Sage license server so that the correct products, features, and number of 
license uses are available to you. 

License Administration Tool Logon

About accessing the License Administration Tool

You use the License Administration Tool for two purposes:

• To activate and manage your Sage Master Builder product license, 
you must log on to the License Administration Tool in administration 

Important:
Before you can use Sage Master Builder with your activated 
license, you have to specify the computer on your network that 
is the Sage license server when you launch Sage Master Builder. 

Related topics...
Setting the Administrator password
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mode. At the first launch of the tool, you can set the administration 
password. Use administration mode to add and update the product 
licenses, change the password, set up License Groups and license use 
reservations.

• To view who on your network is using Sage Master Builder, open the 
License Administration Tool read-only mode.

When you launch the License Administration Tool, the program displays 
the License Administration Tool Logon window. This window offers 
two options:

• Open the License Administration Tool in read-only mode. Use this 
mode to determine who is using Sage Master Builder. For example, 
you need to use Sage Master Builder for a task that requires 
exclusive access. When you open the tool in read-only mode, you 
can see who is using the program. 

• Open the License Administration Tool in administration mode. Use 
this mode to manage, add, or remove license uses or to register new 
modules. The first time you open the License Administration tool, 
you must set the password. Selecting this option, displays a box or 
boxes for setting your password and two links, I forgot my 
password and Change password. Clicking either of these links 
launches other windows which enable you either to change or reset 
the administration password.

Logging on with read-only mode

1. Double-click the LA desktop icon. 

Important:
• We strongly recommend that you write down your the 

License Administration Tool password and save it in a safe 
place. If you forget your password, you have to call Sage 
Customer Support to reset it.

• Before you can log on and manage the license using the 
License Administration Tool from a client workstation, the 
\MB7 folder must be shared on the computer that is the 
Sage license server. For information about sharing folders, 
see the Microsoft Windows Help.
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2. On the License Administration Tool Logon window, accept the 
option, Open the License Administration Tool in read-only mode. 
For example, use read-only mode to determine who is using Sage 
Master Builder.

3. Click OK, then click OK on the message window.
The License Administration Tool opens in read-only mode.

Logging on with administration mode

1. Double-click the LA desktop icon. 

2. On the License Administration Tool Logon window, select the 
option, Open the License Administration Tool in administration 
mode. For example, use this mode to add or remove license uses or 
to register new modules.

3. In the Password box, type your password. 

4. Click OK, then click OK on the message window.
The License Administration Tool opens in administration mode. 

Setting the password

After the License Administration Tool has been successfully installed, 
clicking the License Administration Tool desktop icon opens the License 
Administration Tool Logon window.

Note: 
Your License Administration Tool password is case-sensitive. 

Important: 
• We strongly recommend that you write down your 

administrator user password and save it in a safe place. If 
you forget your password, you have to call Sage Customer 
Support to reset it. 

• Before the Administrator can log on and manage the license 
using the License Administration Tool from a client 
workstation computer, the \MB7 folder must be shared on 
the computer is the Sage license server. For information 
about sharing folders, see the Windows Help.
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To set the administrator user password: 
1. In the Password box, type a password. 

2. In the Confirm Password box, re-type the password and click OK.

3. The License Administration Tool window opens. From this 
window you can manage your product license, license groups, and 
license use reservations.

Changing the password

To change the administration password: 
1. Double-click the LA desktop icon. 

2. On the License Administration Tool Logon window, select the 
option, Open the License Administration Tool in administration 
mode. For example, use this mode to add or remove license uses or 
to register new modules. 

3. Click the text link, Change my password. 

4. On the Change Password window in the Old Password box, type 
your old password. 

5. In the Password box, type a new password.

Note: 
Your License Administration Tool password is case-sensitive.

Important: 
• We strongly recommend that you write down your 

administrator user password and save it in a safe place. If 
you forget your password, you have to call Sage Customer 
Support to reset it. 

• Before you can log on and manage the license using the 
License Administration Tool from a client workstation, the 
\MB7 folder must be shared on the computer that is the 
Sage license server. For information about sharing folders, 
see the Microsoft Windows Help.
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6. In the Confirm Password box, type a new password again, and click 
OK.

The License Administration Tool window opens. From this 
window you can manage your product license, license groups, and 
license use reservations.

Resetting the password

To reset the administrator user password, you have to contact Sage 
Customer Support.

To reset the administrator user password: 
1. On the Logon Administrator Password window, click I forgot my 

password. 
The Forgotten Password window opens.

2. Read the instructions, phone Sage Customer Support at 800-866-
8049, and type the temporary password they provide in the box.

You can also ask them to send you the temporary password in an 
email message. From that message, you can copy and paste the 
temporary password into the Forgotten Password box. 

3. Click OK.

Important:
• We strongly recommend that you write down your 

administrator user password and save it in a safe place. If 
you forget your password, you have to call Sage Customer 
Support to reset it. 

• Before the Administrator can log on and manage the license 
using the License Administration Tool from a client 
workstation computer, the \MB7 folder must be shared on 
the computer that is the Sage license server. For information 
about sharing folders, see the Windows Help.

Important: 
Type the temporary password exactly as provided by Sage 
Customer Support. Passwords are case-sensitive.
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4. The Change Password window opens. The temporary password is 
now displayed in the Old Password box. The temporary password 
acts as your old password and allows you to set a new password. 

5. In the New Password box, type a new password. 

In the Confirm Password box, re-type the new password and click 
OK. 
The License Administration Tool window opens. From this 
window you can manage your product license, license groups, and 
license use reservations. 

Monitoring Product and Feature Use

About monitoring product and feature use

After activating licenses and reserving the use of Sage Master Builder, 
you can monitor the license use and group reservations from the License 
Administration Tool window.

When you select a Floating use License Type with reservations in the 
License Administration Tool window, the window displays the 
following grids:

• License details for product line

• Summary of product or feature use

• Current users of the product or feature

When you select a Floating use License Type without reservations, the 
window displays the license details Current users of the product or 
feature grid.

When you select a Site License Type, the window displays the license 
details grid and definitions for the Product Line, Product or Feature, 
and License Type.

Tip: 
The terms you see in this topic, such as Status, License Type, 
and so forth are defined in the Glossary under License 
Administration Tool.
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License details for product line
After you add licenses, the license details grid displays the following 
information for the product line:

• Status

• Product Line (Hidden by default. To display, right-click a column 
heading in the grid and select Hide/Show Columns > Product 
Line.)

• Product or Feature

• Reservations Allowed (Hidden by default. To display, right-click a 
column heading in the grid and select Hide/Show Columns > 
Reservations Allowed.)

• License Type

• Total Uses

• Available Uses

• In Use

• Expiration Date

• Version

Summary of product or feature use
After you reserve the use of products and features for a floating use 
license, the Summary of product or feature use grid displays the 
following information for the license that you select in the license details 
grid.

• Reserved For

• Total

• Available

• In Use

Note: 
If you have not added licenses, the grids on the License 
Administration Tool window are empty.
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Current users of the product or feature
After you activate floating use licenses, the Current users of the product 
or feature grid displays the following information for the license that you 
select in the license details grid.

• User Name

• Reserved Under

• Computer Name

• Session ID

• In Use Since

Show and Hide Column Features

About showing or hiding columns

Use the Show/Hide Columns window to select the columns that 
you want to display in the license details grid on the License 
Administration Tool window.

Showing columns

To monitor license use, you may choose to show columns. 

To show columns: 
1. From the License Administration Tool window, right-click a 

column heading in the license details grid and select Hide/Show 
Columns.

2. From the Show/Hide Columns window, select the columns that you 
want to display or click Show All.

3. Click OK.

Related topics...
Showing columns
Hiding columns
Hiding all columns
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Hiding columns

You may want to hide one or several columns for business security 
reasons. 

To hide a column: 
1. From the License Administration Tool window in the license 

details grid, right-click the column heading that you want to hide.

2. Select Hide Column.

Hiding all columns

You may want to hide all the columns for business security reasons. 

To hide all columns
1. From the License Administration Tool window, right-click a 

column heading in the license details grid and select Hide/Show 
Columns.

2. From the Show/Hide Columns window, click Hide All.

3. Click OK.

Related topics...
About showing or hiding columns
Hiding columns
Hiding all columns

Related topics...
About monitoring product and feature use
About showing or hiding columns
Hiding all columns

Note: 
You cannot hide the Product or Feature column.
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Managing Licenses

About managing licenses

Use the Manage Licenses window to add product keys, update product 
keys, and activate licenses.

Importing the license file

License activation is based on either importing a license file or manual 
entry of up to four product keys. Take a moment to locate your product 
keys. They are a series of 16-letter codes used to activate your license. 
They have been sent to you in a license file attached to an email from 
your business partner, on your Sage Master Builder packing slip, and/or 
on a sticker on the CD envelope. 

Use the Import License File window to import a license file into the 
Sage license server. 

To import the license file:
1. Open the e-mail message with the attached license file from Sage or 

your business partner. 

Related topics...
About monitoring product and feature use
About showing or hiding columns
Hiding columns

Related topics...
Importing the license file
Adding or updating product keys
Activating licenses

Note: 
If you did not receive a license file in an email message, follow 
the instructions for adding or updating product keys.
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2. Save the license file attachment to the Windows desktop.

3. From the License Administration Tool window, click Manage 
Licenses.

4. From the Manage Licenses window, click import the license file.

5. From the Import License File window, select the license (.lic) file 
name and click Open.

6. From the Manage Licenses window, click activate the licenses.

7. Click Close.

Adding or updating product keys

License activation is based on either importing a license file or manual 
entry of up to four product keys. Take a moment to locate your product 
keys. They are a series of 16-letter codes used to activate your license. 
They have been sent to you in a license file attached to an email from 
your business partner, on your Sage Master Builder packing slip, and/or 
on a sticker on the CD envelope. 

Use the Add or Update Product Keys window to type the product keys. 
Each time you add or make changes to licenses, you will receive new 
product keys.

To add or update product keys:
1. From the License Administration Tool window, click Manage 

Licenses.

2. From the Manage Licenses window, click type the product keys.

Related topics...
About managing licenses
Adding or updating product keys
Activating licenses

Note: 
If you received an e-mail message with an attached license file 
from Sage, follow the instructions for importing the license file. 
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3.  In the Type the product keys boxes on the Add or Update 
Product Keys window, type the product keys listed on your CD 
envelope or that are printed on your packing slip.

4. On the Add or Update Product Keys window, click Accept 
Product Keys.

5. Click Accept Product Keys.

6. On the Manage Licenses window, click activate the licenses.

7. Click Close.

Activating licenses

After importing the license file or entering product keys, you have to 
activate your licenses. 

To activate your license:
1. On the Manage Licenses window, either import the license file or 

add the product keys. 

2. Click activate the licenses. 

3. Click Close.

When you see two green check marks by Step 1 and Step 2, you know 
that your license has been activated. You can now launch the License 
Administration Tool and specify the computer on your network that is 
the Sage license server.

Related topics...
About managing licenses
Importing the license file
Activating licenses

Related topics...
About managing licenses
Importing the license file
Adding or updating product keys
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Managing Reservations

About managing group reservations

Use the Group and Uses columns on the Manage Reservations window 
to reserve product and feature uses for groups.

When a user logs in to a Sage Master Builder company, the Sage license 
server assigns a license use from the first available group to which the 
user belongs. If no reserved license uses are available, the Sage license 
server assigns a license use from the unreserved license uses. 

Setting up group reservations

Use the Group and User columns on the Manage Reservations window 
to reserve license uses for groups.

When a user logs in to a Sage Master Builder company, the Sage license 
server assigns a license use from the first available group to which the 
user belongs. If no group reservations are available, the Sage license 
server assigns a license use from the unreserved uses.

To set up group reservations:
1. From the License Administration Tool window, click Manage 

Reservations. 

The Manage Reservations window for this product line opens.

2. In the Group column, type the name of the first group of users.

You can assign any group name that works for your purposes. 

Important: 
If no reserved or unreserved license uses are available, you 
cannot launch Sage Master Builder connected. You can only 
launch the program disconnected with exclusive access. 

Important: 
You must import the license file or enter product keys before 
you set up group reservations.
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3. In the Uses column, type the number of license uses that you want to 
reserve for this group.

4. Repeat steps 2 and 3 for each group.

5. Click OK.

Removing group reservations

You may need to create new reservation groups when you hire new 
employees or open a new office. 

To remove group reservations: 
1. From the License Administration Tool window, click Manage 

Reservations.

2. From the Management Reservations window, select the row for the 
Group that you want to remove.

3. Click the Delete the selected row (the X button). 

4. Click OK.

Important: 
The total number of Uses for all groups cannot exceed the Total 
Uses listed for this product on the License Administration Tool 
window. 

Tip: 
If you want to retain some unreserved license uses, do not 
reserve all license uses for groups.

Related topics...
About managing licenses
Activating licenses
Removing group reservations
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Troubleshooting Network Disconnection Issues

Disconnected from the network

If a workstation is disconnected from the Sage license server while you 
are using the License Administration Tool, the system displays a 
Disconnected from the License Server message.

Since our products run on your company's network, it is important to 
maintain the network connection between workstations and the Sage 
license server. When your workstation is disconnected from the Sage 
license server, you cannot perform license administration functions using 
the License Administration Tool on the workstation. 

To reconnect to the license server:
1. Wait a few minutes, and then try again to use the License 

Administration Tool.

2. If the workstation is still disconnected, check whether the network 
cable is unplugged.

3. If the workstation remains disconnected, check whether a network 
drive is disconnected.

4. Contact your network administrator.

When the connection is restored, the License Administration Tool returns 
to normal and you can perform any of its functions.

Note: 
This information does not apply if you are running Sage Master 
Builder and the Sage license server on one computer as a stand-
alone installation. 

Related topics...
Network cable unplugged
Disconnected network drive
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Network cable unplugged

When the network cable is unplugged from your workstation, you cannot 
perform license administration functions using the License 
Administration Tool. 

To check whether a network cable is unplugged:
1. Check the notification area, at the far right of the taskbar, for this 

message: A network cable is unplugged.

2. If you see this message, reconnect the network cable to the 
workstation.

3. If you do not see this message, check the network connections.

a. Click Start, and select Control Panel > Network Connections.

b. In the LAN or High-Speed Internet section, check the Status 
of the Local Area Connection.

c. If the Status is Network cable unplugged, reconnect the 
network cable to the workstation.

d. If the Status is Connected, the network cable is connected to the 
workstation.

4. Try to use the License Administrator Tool.

Disconnected network drive

When your workstation is disconnected from the network drive for the 
Sage license server, you cannot perform license administration functions 
using the License Administration Tool. 

To check whether a network drive is disconnected:
1. Click Start, and select My Computer.

2. In the Network Drives section, check the Type column for the 
network drive for the Sage license server.

Related topics...
Disconnected from the network
Disconnected network drive
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3. If the Type is Disconnected Network Drive, select the network 
drive and then select another network drive.

4. If the Type changes to Network Drive, try to use the License 
Administrator Tool.

5. If the Type remains Disconnected Network Drive, contact your 
network administrator.

Related topics...
Disconnected from the network
Network cable unplugged
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License Use and Sage Master Builder
This chapter provides information about the following:
Specify Sage License Server

Running Sage Master Builder Connected
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Specify Sage License Server

About specifying the Sage License Server

Before you can use Sage Master Builder with your activated license, you 
have to specify the computer on your network that is the Sage license 
server. There are two ways to specify the Sage license server: 

• You can select the computer from the list of computers on your 
network or

• You can enter the IP Address or name of the computer 

Selecting the Sage license server computer

One method is to select the computer running the Sage license server 
from the list of network computers. 

To select the computer running Sage license server from the 
list of network computers:
1. On the Select License Server window from the list of network 

computers, select the computer running the Sage license server. 

2. Click OK. 

Related topics...
Selecting the Sage license server computer
Entering the IP Address or name of the computer
Determining the name of a computer
Determining the IP Address of a computer
What is an IP Address?
What is a server?

Note: 
To use this method of selecting a server from the list of network 
computers, you must have already clicked the appropriate link 
on the Specify Sage License Server window.
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Entering the IP Address or name of the computer

One method is to enter the IP Address or name of the computer running 
the Sage license server. 

To enter the IP Address or name of the computer running the 
Sage license server:
1. In the text box, type the IP Address or name of the computer. 

2. Click OK.

Determining the name of a computer

Related topics...
About specifying the Sage license server
Entering the IP Address or name of the computer
Determining the name of a computer
Determining the IP Address of a computer

Note: 
To use this method of selecting a server from the list of network 
computers, you have already clicked the appropriate link on the 
Specify Sage License Server window. 

Related topics...
About specifying the Sage license server
Selecting the Sage license server computer
Determining the name of a computer
Determining the IP Address of a computer
What is an IP Address?

Note: 
If you are trying to determine the name of the computer running 
the Sage license server, you must complete this procedure on 
that computer.
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To determine the name of a computer: 
1. Click Start, Settings, and then Control Panel. 

2. From the list, scroll to and double-click System. 

3. The System Properties window appears.

4. Locate the line Full computer name, and write it down or type it 
into a note that you can print. 

5. Click Cancel. 

Determining the IP Address of a computer

To determine the IP Address of a computer:
1. Click Start, then Run. 

2. In the Open text box, type cmd, then click OK.

3. The \Windows\...\cmd.exe window appears.

4. At the prompt, type ipconfig. 

For example, you might see H:\. Type ipconfig after the drive 
letter. When you press the Enter key, the system displays several 
addresses, among which is the IP Address of the computer. You see a 
line similar to this: 
IP Address . . . . . . . .172.20.22.142

Related topics...
About specifying the Sage license server
Entering the IP Address or name of the computer
Determining the IP Address of a computer

Note: 
If you are trying to determine the IP Address computer running 
the Sage license server, you must complete this procedure on 
that computer. 
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What is an IP Address?

Every computer connected to the Internet is assigned a unique number 
known as an Internet Protocol (IP) address. This numeric address of a 
computer on the Internet is written as a set of four numbers separated by 
periods (each number can range from 0 to 255). An example of an IP 
Address is 123.123.4.5. 

What is a server?

There are many kinds of servers. Some servers are denoted by their 
hardware configuration and a specialized operating system. Other servers 
consist of specialized software applications running on standard 
computers. 

Some servers are called “file servers” and may be a powerful computer 
dedicated to storing files and data. For example, Sage Master Builder 
company data can be stored on a file server. Any Sage Master Builder 
user on the same network as the file server can access and store data 
there. 

Related topics...
About specifying the Sage license server
Entering the IP Address or name of the computer
What is an IP Address?
What is a server?

Note: 
If you are trying to determine the IP Address of the computer 
running the Sage license server, you must complete the 
procedure on that computer. 

Related topics...
About specifying the Sage license server
Entering the IP Address or name of the computer
Determining the IP Address of a computer
What is a server?
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A server can also be a software application that provides a specific kind 
of service to client software running on other computers. The term server 
can refer to a particular piece of software, such as the Sage license server. 
When we refer to the Sage license server, we are describing a computer 
that is running the Sage license server software. 

Running Sage Master Builder Connected

Launching and running Sage Master Builder connected

The desired Sage License Server Connection State is:
Connected: License use acquired. This connection state allows you to 
use all the power of the Sage Master Builder product that you purchased 
and licensed. Running connected means that your computer is connected 
to the Sage license server, and there is a license use available to you.

Prerequisites for a launching and running connected include:
• An activated Sage Master Builder product license. The administrator 

user activates the product license using the functions of the License 
Administration Tool.

• A network connection, if you are on a network. This only pertains to 
working in a network environment and does not pertain to a single 
computer running in a stand-alone environment.

•  The Sage license server that has been specified from the computer 
running Sage Master Builder. 

• An available license use.

• Being a user and having access to a Sage Master Builder company.

Note: 
If you are having a problem running Sage Master Builder 
connected, it is very likely a network problem or your 
computer’s connectivity to your network. If problems persist, 
consult with your local system administrator. 
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To launch and run Sage Master Builder connected:
1. Double-click the Sage Master Builder desktop icon.

2. The Specify Sage License Server window appears. 

3. Choose one of the following: 

• Select the Sage license server from the list of computer on 
your network.

• Enter an IP Address or name of the computer that is the 
Sage license server.

4. When you have satisfied the conditions to specify the Sage license 
server, click OK. 

Sage Master Builder begins its launch process. 

5. On the Company List window, select a company, or click Cancel. 

6. From the Company List window, select a company. 

7. On the User Name and Password window, enter your user name 
and password. 

8. Sage Master Builder opens the company. 

You are now running Sage Master Builder connected.

About the Sage License Server Connection states

You can view the current connection state to the Sage license server in 
the About Sage Master Builder window. Your connection state is 
defined by several factors involving your network connectivity and the 
availability of license uses. The following table presents connection state 
definitions: 

Sage license server 
connection state

About Sage Master Builder window 
displays

Connected
You have launched Sage 
Master Builder but not logged 
in to a company yet.

Connected: License use not acquired. 
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Connected
You have successfully logged 
in to a company.

Connected: License use acquired.

Connected
After a successful login, you 
have chosen to open a new 
company, change user name/
access, or change the Sage 
license server.

Connected: License use returned.

Originally connected, later 
disconnected, now 
reconnected 
You have successfully logged 
in, but you lost connection to 
Sage license server and the 
license use has expired. Now 
you are connected again but 
when you try to acquire a 
license use, no uses are 
available.

Connected: License use lost.

Disconnected 
You are disconnected at launch 
or at subsequent log in when 
selecting a company.

Disconnected: x uses remaining, or 
Disconnected: One use remaining.

Connected
Your educational or trial 
product has expired. 

Activated license has expired. 

Connected
Your unauthorized product has 
expired. 

The seven-day grace period for license 
activation has expired. 

Sage license server 
connection state

About Sage Master Builder window 
displays
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Viewing the Sage license server connection state

You can view the current connection state of the Sage license server. This 
may help you in situations where your Sage license server connection 
status is not what you expect it to be. Viewing the connection state can 
help you troubleshoot problems. 

To view the Sage license server connection state: 
1. From the Sage Master Builder main window, click Help, then click 

About Sage Master Builder. 

The About Sage Master Builder window appears.

2. In the lower right of the window just above the Close button, look 
for Sage License Server Connection State. 

The text in the box displays the current connection state. 

Company List window 

About the Company List window

During installation, you have the option to install Sage Master Builder on 
a specific local drive, such as C:, D:, etc. When you launch Sage Master 
Builder, the first window that appears is Company List. From this 
window, you select the location of company you want to open, then you 
select the company itself, and click OK. 

For example, if you have installed Sage Master Builder and the Sample 
Company on local drive C:, and this is the first time you have launched 
the program, then the program displays the local drive, and the Sample 
Company appears in the list directly below. 

Note: 
If the computer running the Sage license server becomes 
disconnected from the other computers on your network, or if 
your computer becomes disconnected from the Sage license 
server, you may see an alert message from Sage Master Builder 
telling you that you are disconnected. 
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In most business situations, the company that you use to manage your 
business is not located on your local computer; it is located on a server 
computer on your local area network. The server could be a dedicated 
server in a client/server configuration or it could be a colleague’s 
computer in the next office using a peer-to-peer configuration.

In a network environment, clicking the drop-down arrow displays all the 
local drives and all the network drives that you have access to. In the 
following graphic, you can see a list of network drives that have been 
mapped to from this computer.

If you can see the shared network drive in the list, then you can access 
the Sage Master Builder company located on that drive. If you cannot see 
the drive where the company is located, then ask yourself these questions 
or consult with your network administrator to locate your company. 

1. Have you lost your network connection? If you have, then you 
cannot access network drives and the Sage Master Builder company. 

2. Has the server lost its network access or crashed? If that has 
happened, then you can access the server and the company. 

3. Has the company been moved to a different computer and drive? If 
that’s true, the you have to map to the network drive in its new 
location. 

Mapping a network drive to access a company

You may have to map to a network drive to access a Sage Master Builder 
company if it is not located on a drive on your local computer. Let’s 
suppose that the company has been moved to network drive Z: Now to 
access the company data, you have to map to drive Z.

To map a network drive to access a company: 
1. On your Windows desktop, click Start > Explore. 

2. On the tool bar, click Tools > Map Network Drive.

3. On the Map Network Drive window, click Browse. 

4. Locate the drive, and then click OK. 

5. On the Map Network Drive window, click Finish. 

6. Launch Sage Master Builder. 
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7. On the Company List window, select drive Z. 

8. Select the company, and click OK. 

Related topics...
About the Sage License Server Connection states
Mapping a network drive to access a company
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Special Configurations
This appendix provides information about the following:
Windows 7 Professional and Server 2008 R2 Standard Operating 
Systems

Windows Vista and Server 2008 Operating Systems

Windows Server 2003 Operating System

Windows XP Professional Operating System

Citrix and Terminal Servers

Data Backup
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Windows 7 Professional and Server 2008 R2 
Standard Operating Systems

Launching Sage Master Builder to run as administrator for 
scheduling reports 

Microsoft Windows has changed security rules in the Windows 7 
Professional and Server 2008 R2 Standard operating systems to make 
your computer more secure. If you are running Sage Master Builder as a 
typical user, then you have limited privileges in some areas of the 
program, such as saving a report schedule or viewing My Scheduled 
Reports. So, to save a report schedule or view My Scheduled Reports, 
you must launch Sage Master Builder with the command to either Run 
as administrator or Run this program as an administrator.

When you select either command, the settings are limited to you 
personally. Your settings to run Sage Master Builder as administrator do 
not affect the next person who logs on and launches Sage Master Builder 
from this computer. Your settings on this computer can either be 
temporary or persistent. For example, when you select Run as 
administrator, you run the program as administrator for that session 
only. When you select Run this program as an administrator, you set 
program properties to always run the program as administrator when you 
log on to this computer. 

Important: 
On computers running Windows 7 Professional or Server 2008 
R2 Standard, scheduling Sage Master Builder reports and 
viewing My Scheduled Reports requires that you to “run as 
administrator” or to “run the program as administrator.”

Note: 
Run as administrator and Run this program as an 
administrator are not related to Windows 7 Professional or 
Server 2008 R2 Standard operating systems user groups but are 
limited to a specific program you are running. 
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To set Run as administrator:
1. On your Windows desktop, right-click the Sage Master Builder 

program icon. 

2. From the drop-down menu, to launch the program, click Run as 
administrator. 

To set Run this program as an administrator: 
1. On your Windows desktop, right-click the Sage Master Builder 

program icon. 

2. From the drop-down menu, click Properties. 

3. On the Sage Master Builder Properties window, click the 
Compatibility tab. 

4. Under Privileges Level, select Run this program as an 
administrator.

5. Click Apply, and then click OK. 

Windows 7 Professional and Server 2008 R2 Standard “Sleep 
Mode” prevents computers from obtaining a license use 

If a computer running the Windows 7 Professional or Server 2008 R2 
Standard operating system is used as a license server, when it goes into 
sleep mode other computers on the network can’t obtain a license. 
Possible resolutions are: 

• Use a different computer on your network to be the Sage license 
server. Any supported operating system can be used in place of 

Note: 
Selecting Run as administrator only runs the current session of 
running Sage Master Builder. The setting does not persist. 

Note: 
Selecting Run this program as an administrator always runs 
the program with these properties when you launch the program 
on this computer. The setting persists. 
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Windows 7 Professional or Server 2008 R2 Standard. For example, 
use a computer running Windows XP Professional.

• Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never:”
1. Click Start > Control Panel > System and Security > Power 

Options. 

2. Select Change when computer sleeps. 

3. From the Put computer to sleep list, select Never. 

Sage licensing (Sage Service Host) cannot auto-start on Windows 
7 Professional and Server 2008 R2 Standard 

The Sage licensing service (Sage Service Host) cannot auto-start on 
computers running the Windows 7 Professional or Server 2008 R2 
Standard operating systems. If the service stops, the program displays a 
message advising you to take further action to resolve this issue.

Solution for Server 2008 R2 permission error message

If you encounter a permissions error message when launching Sage 
Master Builder on a computer running Windows Server 2008 R2, follow 
these steps to resolve the issue:

1. On the Window desktop, right-click Start, and then click Open 
Windows Explorer. 

2. On the left side of the window, under Computer > Local Disk, 
right-click the \MB7 folder, and then select Properties.

3. On the MB7 Properties window, click the Security tab.

4. From the list under Group or User Names, select USERS, and then 
click the Edit button.
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5. On the Permissions window, select USERS again, and under Allow, 
select the Full control check box. 
Selecting Full control, selects all the check boxes necessary for this 
solution. 

6. On the Permissions window, click OK, and then on the MB7 
Properties window, click OK. 

Server 2008 R2 network configuration and TCP Remoting Channel 

Sage Master Builder uses the TCP Remoting Channel, a Microsoft .NET 
Framework component to enable communication among computers on a 
network. File and printer sharing on computers running the Server 2008 
R2 operating system must be enabled. To enable file sharing, follow the 
instructions in the Windows Server 2008 R2 Help.

Windows Vista and Server 2008 Operating Systems

Installation and AutoPlay

Program installations begin immediately upon inserting the CD into the 
CD-ROM drive if AutoPlay is set to begin automatically. With 
computers running the Windows XP operating system, you can start the 
installation manually by using the Start > Run > Browse command to 
locate and select setup.exe. With computers running the Vista and 
Server 2008 operating systems, this command path has changed. 

• On Vista, click the Vista button (left circular button at lower left of 
the system tray) to open a window with the Start/Search text box at 
the bottom. Type setup.exe in the text box, and press the Enter 
key. When the system search locates the file on the CD, double-click 
the file to begin the installation process.

• On Server 2008, click Start > Run > Browse. Locate setup.exe, 
on the CD, and double-click the file to start the installation. 
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Launching Sage Master Builder to run as administrator for 
scheduling reports

Microsoft Windows has changed security rules in the Vista and Server 
2008 operating systems to make your computer more secure. If you are 
running Sage Master Builder as a typical user, then you have limited 
privileges in some areas of the program, such as saving a report schedule 
or viewing My Scheduled Reports. So, to save a report schedule or 
view My Scheduled reports, you must launch Sage Master Builder with 
the command to either Run as administrator or Run this program as 
an administrator.

When you select either command, the settings are limited to you 
personally. Your settings to run Sage Master Builder as administrator do 
not affect the next person who logs on and launches Sage Master Builder 
from this computer. Your settings on this computer can either be 
temporary or persistent. For example, when you select Run as 
administrator, you run the program as administrator for that session 
only. When you select Run this program as an administrator, you set 
program properties to always run the program as administrator when you 
log on to this computer. 

To set Run as administrator:
1. On your Windows desktop, right-click the Sage Master Builder 

program icon. 

Important: 
On computers running Vista or Server 2008, scheduling Sage 
Master Builder reports and viewing My Scheduled Reports 
requires that you to “run as administrator” or to “run the 
program as administrator.”

Note: 
Run as administrator and Run this program as an 
administrator are not related to Vista or Server 2008 operating 
systems user groups but are limited to a specific program you are 
running. 
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2. From the drop-down menu, to launch the program, click Run as 
administrator. 

To set Run this program as an administrator: 
1. On your Windows desktop, right-click the Sage Master Builder 

program icon. 

2. From the drop-down menu, click Properties. 

3. On the Sage Master Builder Properties window, click the 
Compatibility tab. 

4. Under Privileges Level, select Run this program as an 
administrator.

5. Click Apply, and then click OK. 

Vista and Server 2008 “Sleep Mode” prevents computers from 
obtaining a license use

If a computer running the Vista or Server 2008 operating system is used 
as a license server, when it goes into sleep mode other computers on the 
network can’t obtain a license. Possible resolutions are: 

• Use a different computer on your network to be the Sage license 
server. Any supported operating system can be used in place of Vista 
or Server 2008, for example, Windows XP.

• Set Sleep Mode on your license server computer to Never.

Note: 
Selecting Run as administrator only runs the current session of 
running Sage Master Builder. The setting does not persist. 

Note: 
Selecting Run this program as an administrator always runs 
the program with these properties when you launch the program 
on this computer. The setting persists. 
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To set the Sleep Mode to “Never:”
1. Start > Control Panel > System and Maintenance > Power 

Options. 

2. Select Change when computer sleeps. 

3. From the Put computer to sleep list, select Never. 

Sage licensing (Sage Service Host) cannot auto-start on Vista and 
Server 2008

The Sage licensing service (Sage Service Host) cannot auto-start on 
computers running the Vista or Server 2008 operating systems. If the 
service stops, the program displays a message advising you to take 
further action to resolve this issue.

Solution for Server 2008 error message about mb7.kpr file

If you encounter an error message about opening the mb7.kpr file 
when launching Sage Master Builder on a computer running Windows 
Server 2008, follow these steps to resolve the issue:

1. On the Window desktop, right-click Start, and then click Explore. 

2. On the left side of the window, under Folders, right-click the MB7 
folder, and then select Properties.

3. On the MB7 Properties window, click the Security tab.

4. From the list under Group or User Names, select USERS, then 
click the Edit button. 

5. On the Permissions window, select USERS again, and under Allow, 
select the Full control check box. 
Selecting Full control, selects all the check boxes necessary for this 
solution. 

6. On the Permissions window, click OK, and then on the MB7 
Properties window, click OK. 

Vista/Server 2008 installation and mapped drives

 Mapped drives may not be available when installing on a computer 
running the Vista or Server 2008 operating systems. See the Microsoft 
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knowledgebase article about allowing mapped drives to display elevated 
users: http://support.microsoft.com/kb/937624/ 

Vista and Server 2008 network configuration and TCP Remoting 
Channel

Sage Master Builder uses the TCP Remoting Channel, a Microsoft .NET 
Framework component to enable communication among computers on a 
network. File and printer sharing on computers running the Vista/Server 
2008 operating system must be enabled. To enable file sharing, follow 
the instructions in the Vista/Server 2008 Help.

Vista and Server 2008 and changing the Sage License Server 
computer

On a Vista or Server 2008 workstation, when you select File > Change 
Sage License Server > Select the computer from the list of computers 
on your network, the command may fail to generate a list of network 
computer names. To resolve this issue, click Enter the IP address or 
name of the computer and type the IP Address of the server computer in 
the box.

Windows Server 2003 Operating System

Configuring Windows Server 2003 date format

It is necessary when using Windows Server 2003 to configure the date 
format. 

Note: 
If you need to install to a mapped drive, install the program to a 
computer that is running another supported operating system, 
such as Windows XP. 

Note: 
Configuration for Windows Small Business Server 2003 is the 
same as configuration for Windows Server 2003.
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To configure the Windows Server 2003 date format:
1. Click the Start button, point to Control Panel, then click Regional 

and Language Options.

2. On the Regional and Language Options dialog box, on the 
Regional Options tab, click the Customize... button.

3. On the Customize Regional Options dialog box, click the Date tab.

4. Under Short date, from the Short date format drop-down list, 
select MM/dd/yyyy.

5. Click OK.

6. To close Customize Regional Options, click OK again.

Setting up Windows Server 2003 for PDF and RTF printers

In Windows Server 2003 (Standard Edition) and Windows Server 2003 
(Enterprise Edition), the installation of kernel-mode drivers is blocked by 
default. Before you can install Sage Master Builder PDF and RTF 
printers with Windows 2003 Server, you have to unblock the installation 
of the kernel-mode drivers and edit the Group Policy.

To unblock the installation and edit the Group Policy: 
1. On your Windows Server desktop, click Start, then Run....

The Run dialog box opens.
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2. In the Open: text box, enter gpedit.msc, and then press the Enter 
key.

The Group Policy window opens.

3. In the left pane, on the Tree tab, double-click the Administrative 
Templates folder.

4. Then double-click the Printers folder.

5. In the right pane, in the Setting list, find and set the state of the 
setting for Disallow installation of printers using kernel-mode 
drivers to Disable.

Windows XP Professional (SP2) Operating System

Configuring the Windows XP Professional date format

To configure the date format:
1. Click the Start button, point to Settings, and click Control Panel.

2. Double-click the Regional and Language Options icon, and click 
the Regional Options tab.

3. Click the Customize button and the Date tab.

4. In the Short Date Format list, select MM/dd/yyyy.

5. Click OK.

Citrix and Terminal Servers

Using Citrix and Terminal Server with Sage Master Builder

Many people use Citrix and Terminal Server to manage remote access to 
their local area network (LAN). If Sage Master Builder is installed on the 
computer running Citrix or Terminal Server and on your laptop, then you 
may log on to the computer running Citrix or Terminal Server with your 
laptop and work in Sage Master Builder on your LAN. This enables you 
to work from home, from a job site, or from any number of other remote 
locations. 
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We recommend that you use DOS commands to change the operating 
mode from “execute” to “install” and then back to “execute.” When 
using the DOS commands to install, you may install the Sage Master 
Builder software as you would on any desktop or Windows server 
operating system that meets Sage Master Builder requirements.

Installing on computers running Citrix and Terminal Server using 
DOS commands

To install using DOS commands:
1. Click Start, then Run. 

2. On the Run window, in the Open drop-down box, type cmd, and 
press the ENTER key. 

The \Windows\...\cmd.exe window appears.

3. At the prompt, type change user /install, and press the 
ENTER key.

This enables the install mode. 

4. Install the Sage Master Builder software as you would on a typical 
workstation or Windows Server.

5. At the end of the installation process, choose to launch the License 
Administration Tool. 

6. Using the License Administration Tool window, manage your license 
and activate it. 

7. After activation, click Start, then Run. 

8. On the Run window, in the Open drop-down box, type cmd, and 
press the ENTER key.

9. The \Windows\...\cmd.exe window appears. 

10. At the prompt, type change user /execute. 

This enables the execute mode, which is the default mode for 
running Citrix and Terminal Server. 

11. Exit the Run window. 

12. Restart the server. 
90



 Special Configurations
Backing Up Your Data

Data backup

With any computer system, there is the possibility for failure and loss of 
data. For more information about backing up data, refer to the Sage 
Master Builder Help. 

Which files to back up in Sage Master Builder

When you back up your company data, we recommend that you back up 
your company financial data as well as all your custom reports and 
forms. If you are running multiple Sage Master Builder companies, back 
all of them up. 

When backing up data as part of the year-end close process, it is 
important to count the number of files and folders in your company. To 
see the number of files and folder in a company folder, in Windows 

Important:
• Before users will be able to launch Sage Master Builder 

through the Terminal Server, the server must be restarted. 
• If this message appears: “Install mode does not apply to a 

terminal server configured for remote administration,” then 
it is not necessary to enable the install mode. You may 
install the Sage Master Builder software as you would on a 
typical workstation.

Caution!
Use a backup method and device suitable for your business 
requirements. We strongly recommend that you maintain a 
routine backup schedule and store your data in a safe 
environment that is separate from your server, preferably off 
site.

Note: 
This topic only applies to existing Sage Master Builder 
customers. 
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Explorer, right-click the company folder and select Properties. On the 
Properties window, the General tab, look in the list for the Contains 
line for the number of files and folders. Write this number down so that 
you can refer to it after you have made the two copies. The number of 
files and folders has to be exactly the same in both the company and the 
backup copy. 

We strongly recommend that you back up:

• Each company folder that contains financial data (\MB7\your 
company\)

• The Custom Reports folder (\MB7\Custom Reports)

• The Report Forms folder (\MB7\Report Forms)

• The System Reports folder (\MB7\System Reports)

An example of one backup method

There are various methods for backing up your data. Depending on the 
amount of data entry you routinely perform, you might consider making 
full daily backups. It is also a good idea to regularly take one backup off 
the business premises or store them in a fireproof safe. If a burglary or 
fire occurs, a copy of your data is safe from harm.

One reliable procedure, requiring a tape drive and multiple sets of tapes, 
requires you to make daily and monthly backups. For the daily backup 
process, you need 10 tapes. Label five of the tapes as Week A, with a 
tape designated for each weekday. Label the other five tapes as Week B, 
with a tape designated for each weekday.

Caution!
If you are working across a network, you must remember to 
backup company folders, report folders, and form folders that 
reside at the server. 

Caution!
When backing up your data, be sure to make a full backup and 
not an incremental or differential backup. An incremental or 
differential backup only records alterations to the data since the 
last backup.
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Start with the set of tapes labeled Week A. Monday night when you make 
the backup use the tape labeled Monday, on Tuesday use the tape labeled 
Tuesday, and so forth. At the start of the next week, use the set of tapes 
labeled Week B to make your backups. At the end of two weeks, you will 
have a data backup for each day. Then at the start of the third week, use 
the set of tapes labeled Week A again. Over the course of a year, you will 
cycle through the two sets of tapes. Be sure to store the most recent 
Friday backup off site.

For the monthly backups, you need a separate set of three tapes labeled 
Month A, Month B, and Month C respectively. Like the weekly backups, 
use each tape to back up the data for a different month, cycling through 
each of the tapes over the course of the year. After making a monthly 
backup, write the month and year on the label to help you track which 
tape to use next. Be sure to remove the most recent monthly backup off 
site.

Backing up your data to a CD or DVD

This topic suggests a generic way to back up your data to a CD or DVD.

When backing up data as part of the year-end close process, it is 
important to count the number of files and folders in your company. To 
see the number of files and folder in a company folder, in Windows 
Explorer, right-click the company folder and select Properties. On the 
Properties window, the General tab, look in the list for the Contains 
line for the number of files and folders. Write this number down so that 
you can refer to it after you have made the two copies. The number of 

Caution!
If you are working across a network, you must remember to 
backup company folders, report folders, and form folders that 
reside at the server. 

Important: 
Backing up to a CD or DVD successfully depends on your 
computer system, including hardware and software. To back up 
to a CD or DVD, you must have access to a CD or DVD (Read/
Write capability), and the appropriate CD or DVD media. 
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files and folders have to be exactly the same in both the company and the 
backup copy. 

To back up your data to a CD or DVD: 
1. Place the CD or DVD media in the CD or DVD. 

2. On your Windows desktop, right-click Start and select Explore. 

3. In Windows Explorer, locate the \MB7\ folder again, right-click the 
Custom Reports folder and from the menu select Copy.

4. Locate the CD or DVD drive, and click it. 

5. Then in the right-pane, right-click and select Paste. 

6. In Windows Explorer, locate the \MB7\ folder again, right-click the 
Report Forms folder and from the menu select Copy.

7. Locate the CD or DVD drive, and click it. 

8. Then in the right-pane, right-click and select Paste. 

9. In Windows Explorer, locate the \MB7\ folder again, right-click the 
System Reports folder and from the menu select Copy.

10. Locate the CD or DVD drive, and click it. 

11. Then in the right-pane, right-click and select Paste. 

12. In Windows Explorer, locate the \MB7 folder. 

13. Right-click a company folder that contains current financial data, 
and from the menu, select Copy.

14. Locate the CD or DVD drive, and click it. 

15. Then in the right-pane, right-click and select Paste. 

16. Repeat 12 through 15 for every active company with current 
financial data. 

Important: 
If the number of files and folders in the original version do not 
match the numbers in the copy, you must repeat the process. It is 
imperative that the copy is an exact duplicate of the original 
company. 
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Depending on your hardware and software, the folder will be copied 
to the CD or DVD media. For further information or support, contact 
your CD or DVD manufacturer.
95



Chapter 6
96



Index
Symbols
.NET

about 18
client requirements 21
server requirements 20

A
Adobe Reader

disengage auto-update 23
API

system requirements 25
AutoPlay

Vista/Server 2008 83
autostart

Vista/Server 2008 86
Windows 7/Server 2008 R2 82

B
backup

data 91, 92, 93
file selection 91

Business Partner
about 7

C
Citrix servers

DOS cmd installation 90
client

network configuration 16
client requirements

.NET 21
column

about 57
hide 58
hide all 58
show 57

computer name
determine 69

configure
Windows Server 2003

date format 87
printers 88

Windows XP
date format 89

connection state
view 75

customer support
about 4
forums 5
knowledgebase 4
online support 5
phone support 5
release updates 4
remote assist tool 5
service plans 5

D
data

backup 91
file selection 91

backup methods 92, 93
date format

Windows Server 2003 87
Windows XP 89

DOS cmd installation
Citrix servers 90
Terminal servers 90

F
Fax modem

use with Sage Master Builder 22
fax service component
97



Index
Windows 24
faxing

operating systems 22
forms

check 7
tax 7

G
group reservations

about 62
set up 62

guides
Installation and License 

Administration 2

I
install

.NET framework 19
installation

about new 33
additional software 29
API 28
change designation 47
different configurations 30
duration 29
License Administration Tool 31
new

Sage license server 34
Sage Master Builder 38

option
update reports 31

Sage license server 34
Sage Master Builder 38
Sample Company 32
scheduled reports 28
upgrade 40, 42, 46

Internet Explorer 6.0
(SP1) verify 21

IP Address
definition 71, 77
determine 70

L
LA Tool Logon

about 50
change password 53
log on admin 52
log on read-only 51
reset password 54
set password 52

License Administration Tool
about 50

license file
import 59

M
mapped drives

Vista installation 86

N
network

connectivity 31
disconnected 64
disconnected drive 65
unplugged 65

network configuration
client and workstation 16
server 15

network drive
update reports 31

O
operating system

fax service component 24
operating systems

faxing 22

P
pre-installation

for existing customers 28
for new customers 28

printers
Windows Server 2003 88
98



Index
product key
add 60
update 60

R
reinstallations 40
reports

faxing and emailing
setup 22

requirements
web browser 14

S
Sage CRE

checks 7
forms 7

Sage license server
about 68
connection state 75
IP Address 69
name 69
reset 45
select 68
where? 50

Sage Master Builder
connected 72

Sage Service Host
autostart 82, 86

server
add new to network 48
definition 71
network configuration 15
Terminal 89

Server 2008
sleep mode 85

Server 2008 R2
sleep mode 81
TCP Remoting Channel 83

server requirements
.NET 20

sleep mode
Server 2008 85

Server 2008 R2 81
Vista 85
Windows 7 81

special configuration
Vista/Server 2008

AutoPlay 83
autostart 86
mb7 kpr file 86
schedule reports 84

Windows 7/Server 2008 R2
autostart 82
schedule reports 80

special configurations
Server 2008 R2

mb7 kpr file 82
system information

viewing 20
system requirements

API 25
client hardware 11
file server hardware 10
operating system 13
server hardware 10
workstation hardware 11

System Verification Tool
about 10

T
Terminal servers

DOS cmd installation 90
training

classes overview 6
getting started 6
options 6

troubleshooting
network 64, 65

U
upgrade

about installation 42
installation 40, 43
post-installation 46
99



Index
upgrade installations 40

V
Version 14

welcome 2
Vista

sleep mode 85
Vista/Server 2008

change license server 87
install to mapped drives 86
schedule reports 84
TCP Remoting Channel 87

W
web browser

requirements 14
Windows

fax service component 24
Windows 7

sleep mode 81
Windows 7/Server 2008 R2

schedule reports 80
100


	Welcome to Sage Master Builder Installation
	Installation Overview
	Welcome to Sage Master Builder installation
	What information is in this book?

	Customer Support Resources
	About customer support resources

	Training Resources
	About training options

	Business Partners
	About Business Partners

	Business Forms
	Sage Construction and Real Estate Forms


	System Requirements and Configuration
	Hardware Requirements
	About system requirements and configuration
	About the Sage System Verifier
	Server hardware specifications
	Server hardware requirements
	Client and workstation hardware requirements

	Operating System Requirements
	Operating systems
	Web browser requirements

	Network Configuration Requirements
	Server network configuration requirements
	Client and workstation network configuration requirements
	About network configuration and TCP Remoting Channel
	Configuring Sage Service Host TCP port numbers
	Configuring third-party firewalls

	Microsoft .NET Framework 3.5 Service Pack 1 Requirements
	About installation and Microsoft .NET Framework
	About installing .NET Framework 3.5 Service Pack 1 and Operating Systems
	Viewing and verifying system information
	.NET Framework Requirements for Server Computers
	Minimum requirements for the .NET Framework 3.5 Service Pack 1 on servers

	.NET Framework Requirements for Client Computers
	Minimum requirements for the .NET Framework 3.5 Service Pack 1 on clients
	Verifying that Microsoft Internet Explorer 6.0 Service Pack 1 is installed


	Report Scheduling and Faxing Functionality
	About setting up emailing and faxing through Sage Master Builder
	Installing the Windows Fax Services component

	Sage Master Builder API
	System requirements for Sage Master Builder API


	Sage Master Builder Installation
	Installation Preview
	Pre-installation information for new customers
	Pre-installation information for existing customers
	Duration of the installation process
	Additional required software
	About installing the Sage Master Builder software to different configurations
	Connectivity across your network
	License Administration Tool
	Option to update reports and report forms on a shared drive during installation
	Installing the Sample Company

	New Installations
	About new installations
	Installing the Sage license server and Sage Master Builder
	Installing Sage Master Builder on client workstations

	Upgrade Installations
	About upgrading Sage Master Builder
	Upgrade Pre-installation
	Upgrade pre-installation tasks

	Upgrade Installation
	About installing the upgrade
	Installing the upgrade
	Resetting the Sage license server computer

	Upgrade Post-installation
	Upgrade post-installation tasks

	Change Sage License Server Designation
	About reinstalling to change the Sage License Server designation

	Add a New Server
	Adding a new server to your network



	Managing Your License with the License Administration Tool
	License Administration Tool
	About the License Administration Tool for Sage Master Builder

	License Administration Tool Logon
	About accessing the License Administration Tool
	Logging on with read-only mode
	Logging on with administration mode
	Setting the password
	Changing the password
	Resetting the password

	Monitoring Product and Feature Use
	About monitoring product and feature use
	Show and Hide Column Features
	About showing or hiding columns
	Showing columns
	Hiding columns
	Hiding all columns


	Managing Licenses
	About managing licenses
	Importing the license file
	Adding or updating product keys
	Activating licenses

	Managing Reservations
	About managing group reservations
	Setting up group reservations
	Removing group reservations

	Troubleshooting Network Disconnection Issues
	Disconnected from the network
	Network cable unplugged
	Disconnected network drive


	License Use and Sage Master Builder
	Specify Sage License Server
	About specifying the Sage License Server
	Selecting the Sage license server computer
	Entering the IP Address or name of the computer
	Determining the name of a computer
	Determining the IP Address of a computer
	What is an IP Address?
	What is a server?

	Running Sage Master Builder Connected
	Launching and running Sage Master Builder connected
	About the Sage License Server Connection states
	Viewing the Sage license server connection state
	Company List window
	About the Company List window
	Mapping a network drive to access a company



	Special Configurations
	Windows 7 Professional and Server 2008 R2 Standard Operating Systems
	Launching Sage Master Builder to run as administrator for scheduling reports
	Windows 7 Professional and Server 2008 R2 Standard “Sleep Mode” prevents computers from obtaining a license use
	Sage licensing (Sage Service Host) cannot auto-start on Windows 7 Professional and Server 2008 R2 Standard
	Solution for Server 2008 R2 permission error message
	Server 2008 R2 network configuration and TCP Remoting Channel

	Windows Vista and Server 2008 Operating Systems
	Installation and AutoPlay
	Launching Sage Master Builder to run as administrator for scheduling reports
	Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license use
	Sage licensing (Sage Service Host) cannot auto-start on Vista and Server 2008
	Solution for Server 2008 error message about mb7.kpr file
	Vista/Server 2008 installation and mapped drives
	Vista and Server 2008 network configuration and TCP Remoting Channel
	Vista and Server 2008 and changing the Sage License Server computer

	Windows Server 2003 Operating System
	Configuring Windows Server 2003 date format
	Setting up Windows Server 2003 for PDF and RTF printers

	Windows XP Professional (SP2) Operating System
	Configuring the Windows XP Professional date format

	Citrix and Terminal Servers
	Using Citrix and Terminal Server with Sage Master Builder
	Installing on computers running Citrix and Terminal Server using DOS commands

	Backing Up Your Data
	Data backup
	Which files to back up in Sage Master Builder
	An example of one backup method
	Backing up your data to a CD or DVD
	Symbols
	A
	B
	C
	date format 87
	printers 88
	date format 89

	D
	file selection 91

	F
	G
	I
	Sage license server 34
	Sage Master Builder 38
	update reports 31

	L
	M
	N
	O
	P
	R
	setup 22

	S
	AutoPlay 83
	autostart 86
	mb7 kpr file 86
	schedule reports 84
	autostart 82
	schedule reports 80
	mb7 kpr file 82

	T
	U
	V
	W


	Index

